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Glossary
A list of words or terms specialized in this document.

Glossary Definition

BSP Board Support Package, the layer of software containing hardware-specific drivers and libraries to function in a
particular hardware environment.

CPU Central Processing Unit.

csv Comma Separated Values file.

DRC Design Rule Check.

DUT Design Under Test.

ESI Previous name of Propel.

FPGA Field Programmable Gate Array.

GUI Graphic User Interface.

HDL Hardware Description Language.

HSM Hardware Security Module.

IDE Integrated Development Environment.

IP-XACT An XML format that defines and describes electronic components and their designs.

LHS Left Hand Side.

LSB Least Significant Bit.

MSB Most Significant Bit.

Programmer A tool can program Lattice FPGA SRAM and external SPI Flash through various interfaces, such as JTAG, SPI, and
12C.

Perspective A group of views and editors in the Workbench window.

RHS Right Hand Side.

RISC.V A free and open instruction set architecture (ISA) enabling a new era of processor innovation through open
standard collaboration.

SBX The files that store the spatial index of the features

SDK Embedded System Design and Develop Kit. A set of software development tools that allows the creation of
applications for software package on the Lattice embedded platform.

SoC System on Chip. An integrated circuit that integrates all components of a computer or other electronic systems.

SRAM Static Random Access Memory.

TCL Tool Command Language.

UFM User Flash Memory.

VIP Verification IP.

Workspace The fiirectory whgre stores your work, it is used as the default content area for your projects as well as for
holding any required metadata.

Workbench Refers to the desktop development environment in Eclipse IDE platform.
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1. Introduction

Lattice Propel™ 2.0 Builder is a graphical tool used to assemble complex System-on-Chip (SoC) modules which can be
used in the supported Lattice FPGA devices. These modules and/or IPs can be assembled and connected easily by
simply dragging and dropping the modules and/or IPs into the Schematic Window.

1.1. Purpose

Embedded system solutions play an important role in FPGA system design allowing you to develop the software for a
processor in an FPGA device. It provides flexibility for you to control various peripherals from a system bus.

To develop an embedded system on an FPGA, you need to design the System on Chip (SoC) with an embedded
processor. Lattice Propel Builder helps you develop your system with a RISC-V processor, peripheral IP, and a set of
tools by a simple drag-and-drop.

The purpose of this document is to introduce Lattice Propel 2.0 Builder tool and design flow to help you quickly get
started to build a small demo system. You can also find the recommended flows of using Lattice Propel Builder in this
document.

1.2. Audience

The intended audience for this document includes embedded system designers and embedded software developers
using Lattice MachX03D, MachX03L, MachXO3LF, MachX02, LIFCL, LFD2NX and LFMNX devices. The technical
guidelines assume readers have expertise in the embedded system area and FPGA technologies.
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2. Lattice Propel Builder Design Flows

The Propel Builder design flow includes creating an SoC project design flow, and verification design flow, which are
discussed in detail in the following sections.

2.1. Builder Environment

After Propel 2.0 is installed, you can launch the stand-alone Propel Builder by double-clicking the Builder icon to launch
Builder. Refer to the Lattice Propel 2.0 Installation for Windows User Guide (FPGA-AN-02036) for details on the
installation. After the Propel Builder is launched, a single workbench window is displayed. The workbench contains
Menu, Toolbar, Design View, IP catalog, Schematic view, address mapping, Start Page and TCL console. Figure 2.1
shows the workbench with opening a project.

1. Menu bar

2. Toolbar

3. IP Catalog and Design View

4. Schematic View, Address Mapping, and Start Page
5. TCL Console

4. Propel Builder [C:/Iscc/workspace/HelloWorld/HelloWarld/HelloWaorld.sbx] Device: LIFCL-40-SBG400C - [m] *

File Edit View Design Tools Window Help l

LERAHCTs GMENOANNS QQaal]2
| P =) Schematic Address Start Page

o & -

IP on Local P on Server A
| L1 Module/IP on Local
* Module
b [ Architecture_Modules
+ [ Processors_Controllers_and_Peripherals
b+ [ Verification IP
v P
b (1 Processors_ Controllers_and_Peripherals
b (7 Security_Subsystem

Fus f= > ws -

concat  equation invert tl split

3 a4

IP Catalog Design View |} n

cl Console m)
% sbp_design open -name HelloWorld —path {C:/lscc/workspace/HelloWorld/HelloWorld/HelloWorld.sbxi

% sbp_design close

INFO - Finished: sbp_design close

Finished: "sbp_design close”

% sbp design open -name HelloWorld -path {C:/lscc/workspace/HelloWorld/HelloWorld/HelloWorld.sbx}
=

Figure 2.1. Propel Builder Workbench Window
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2.2. Project Design Flow
2.2.1. Creating a New SoC Project

1. Choose File > New Design from the Lattice Propel Builder Menu bar. The Create System Design — Design
Information wizard opens (Figure 2.2).

u.h

Design Information
Enter a name for your design and specify a directory where the design files wil be stored.

Project:

Type: SoC Project 7
Mame: EmptyProject

Location: | C:flsccfpropel/2.0/workspace * | | Browse...

Create Project at C: lsce/propel /2.0 fworkspace EmptyProject

Mext = Cancel

Figure 2.2. Create System Design — Design Information Wizard

2. The default Project Type is displayed in the Type field. Use the drop-down menu to choose SoC Verification if
creating a verification project.

3. Enter the desired project name in the Name filed.

4. (Optional) The default location is shown in the Location field. Use the Browse... option to change the project
workspace location.

5. Click Next. The Create System Design - Propel Project Configure wizard opens (Figure 2.3).
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s Create Systern Design

Propel Project Configure
Spedfy a device or board for project.

Language:

Verilog -
Farmnily: Board Processor:

LFD2MX hd RISC-Y MC 7
Device: Templates:

LFD2M%-17 | Helloe World Project
Padage: Ernpty Project

CS5FEGA12] hd
Speed:

7_High-Performance_1.0v -

Device and Template Info:

Hello World Project. Components induded:
a) Processor - RISC-V MC w/ PIC,TIMER.
b) GFIO
c) ASRAM - Asynchronous SRAM
d) UART - Serial port

< Back Mext = Cancel

Figure 2.3. Create System Design - Propel Project Configure Wizard

(Optional) The default Hardware Description Language (HDL) is displayed in the Language field. Use the drop-down
menu to change the default language.

Specify a device or board for project.

Use the drop-down menu to select desired device information (Family, Device, Package and Speed), and select
Empty Project in the Templates section (Figure 2.4).

12
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s Create Systern Design

Propel Project Configure
Spedfy a device or board for project.

Language:

Verilog -
Farmnily: Board Processor:

LFD2MX hd RISC-Y MC 7
Device: Templates:

LFD2M%-17 | Helle World Project
Padage: {Empty Project

CSFEGA121 i
Speed:

7_High-Performance_1.0v -

Device and Template Info:

Empty project for user to “build from
saratches”,

< Back Mext = Cancel

Figure 2.4. Specify a Device for Project

e Click Board. The Propel Project Configure wizard is shown in the Board Select: area (Figure 2.5). Select the
desired board, such as Crosslink-NX Evaluation.
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4. Create System Design by

Propel Project Configure
Spedfy a device or board for project.

Language:
Verilog -
Board Select: Board | Processar:
CrossLink-MX Evaluation RISCY MC -
MachX02 Breakout T e
MachX03D Breakout emplates:
Mach¥Q30 PFR Demo Hello World Project
:Ernpty Project i

Device and Template Info:

Empty project for user to “build from
saratches”,

< Back Mext = Cancel

Figure 2.5. Specify a Board for Project

8. Click Next. The Project Information wizard opens (Figure 2.6).
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4 Create Systermn Design

Project Information
Generate new project with the following spedifications.

Project:

Project Mame: EmptyProject

Project Location: Cflsce/propel/2.0/workspace/EmptyProject
Language: Verilog

Device: LIFCL-40-9BG400C

Template Mame: Emnpty Project

< Back Finish Cancel

Figure 2.6. Create System Design - Project Information Wizard

9. Check and confirm the project information.
10. Click Finish. Propel Builder GUI opens (Figure 2.7).
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Tel Console

“, Propel Builder [C:/Iscc/propel/2.0/workspace/EmptyProjec/EmptyProjec/EmptyProjec.sbx] Device: LIFCL-40-9BG400C - [m| X

File Edit View Design Tools Window Help

o & B8 xoBERE QQQAQ

Design View o Schematic Address Start Page
Ak EmptyProjec =
» gﬂ Ports

Components

clk_i

Properties

MName:

Type: Instance

Path: EmphyProjec rstn_i
VLMY:  lattice:systembuilder :EmptyProjec: 1.0

File:  C:flscefpropel 2.0 /workspace EmptyProjec/EmptyProjec/EmptyProjec. sbx

1P Catalog Design View 4 »

% sbp design open -name EmptyProjec -path {C:/lscc/propel/2.0/workspace/EmptyProjec/EmprtyProjec/EmptyProjec.sbx}
%

Figure 2.7. Propel Builder GUI Shows Empty Project

2.2.2. Creating Template SoC Project

1.

Choose File > New Design from the Lattice Propel Builder Menu bar. The Create System Design wizard opens
(Figure 2.8).
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., Create System Design >

Design Information
Enter a name for your design and specify a directory where the design files will

be stored.
Project:
Type: 50C Project 7
Mame: HelloWorld
Location: | C:flsccfpropel/2.0/workspace * | | Browse...

Create Project at C: lsccfpropel /2.0 /workspace HelloWarld

Mext = Cancel

Figure 2.8. Create System Design — Design Information Wizard

2. The default Project Type is displayed in the Type field. Use the drop-down menu to choose SoC Verification if
creating a verification project.

Enter a project name in the Name field, such as HelloWorld.
(Optional) The default location is shown in the Location field. Use the Browse... option to change the project
workspace location.

5.  Click Next. The Propel Project Configure wizard opens (Figure 2.3).

6. Click Board. The Propel Project Configure wizard is shown in the Board Select area. Select a desired Board, such as
CrossLink-NX Evaluation.

7. Select a desired template from the Templates area, such as Hello World Project (Figure 2.9).
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s Create Systern Design

Propel Project Configure
Spedfy a device or board for project.

Language:
Verilog -
Board Select: Board Processor:
CrossLink-MX Evaluation RISCY MC -
MachX02 Breakout — —
MachX03D Breakout emplates: _
MachXO030D PER Demo iHello World Project :
Ernpty Project

Device and Template Info:

Hello World Project. Components induded:
a) Processor - RISC-V MC w/ PIC,TIMER.
b) GFIO
c) ASRAM - Asynchronous SRAM
d) UART - Serial port

< Back Mext = Cancel

Figure 2.9. Specify a Board for Project

8. Click Next. The Project Information wizard opens (Figure 2.10).
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4. Create System Design et
Project Information
Generate new project with the following spedifications.
Project:
Project Mame: HelloWorld
Project Location: Cflscc/propel/2.0/workspace/HelloWorld
Language: Verilog
Device: LIFCL-40-9BG400C
Template Mame: Hello World Project
< Back Finish Cancel
Figure 2.10. Project Information Wizard
9. Check and confirm the project information.
10. Click Finish. Propel Builder GUI opens (Figure 2.11).
4, Propel Builder [C:/lscc/propel/2. p: bx] Device: LIFCL-40-9BG400C - O X
File Edit View Design Tools Window Help
s B3 D¢ S TRENOHRELIEE @QQaQQ
Design View a Schematic Address Start Page
= 1 HelloWorld =
* {F Instances
» 1F ahbl0_inst
b 1 ahbl2aph0_inst
» I apb0_inst
» I cpul_inst
» IF gpiol inst
v TF oscinst
» IF sysmemO_inst
v TF vartd_jnst
» 2= Ports
» [E Nets

» Components

Properties
Name:

Type: Instance
Path: HelloWorld
VLNV:  lattice:systembuider:HelloWorld: 1.0

Fie:  Cifiscc]

IP Catalog
Tel Console

Design View

%

‘.

% sbp design open -name HelloWorld -path {C:/lscc/propel/2.0/workspace/HelloWorld/HelloWorld/HelloWorld.sbx}

Figure 2.11. Propel Builder GUI shows Template Project
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2.2.3. Opening an SoC Existing Project

[

S =
1. Choose File > “—' Open Design from Propel Builder GUI Menu, or Click Open Design icon “—' from Propel
Builder Toolbar. The Open sbx dialog opens (Figure 2.12).
4 Open shx H
U <« |scc » propel » 2.0 » workspace v O /2 Search workspace
Organize v Mew folder ==~ [H 0
2 MName Date modified Type Size
3 Quick access
.metadata 3/12/2021 1:45PM File folder
[ Desktop - ) _ )
EmptyProject 3/12/2021 2:47 PM File folder
!’ Downloads glue_logic 3/12/2021 1:45 PM File folder
=| Documents  # HelloWorld 3/12/2021 2:49 PM File folder
&= Pictures -
doc
propel
v < >
File name: v| Shx Files (*.shx) ~
Figure 2.12. Open Sbx Dialog
2. Browse to find the default project workspace folder or your own project workspace folder. Choose the sbx file,
such as HelloWorld.sbx (Figure 2.13).
4 Open shx X
&« v « 20 » workspace » HelloWorld » HelloWorld » v ] & Search HelloWorld
Organize * New folder ==~ [ @
I This PC (A Mame Date modified Type Size
_J 3D Objects dib 4/6/2021 316 AM File folder
;| Desktop application 4/6/2021 9:16 AM File folder
@ Docurents lib 4/6/2021 %16 AM File folder
D HelloWorld.sbx /68,2021 216 AM SBX File 633 KB
* Downleads
J‘& Music
&= Pictures
B Videos
= Windowe f01 Y
File name: | HelloWorld.sbx v| Sbx Files (*.sbux) e
Figure 2.13. Open HelloWorld Project
3. Click Open. The Builder GUI shows the SoC design.

Note: Choose File > Recent Designs from Propel Builder GUI Menu. You can quickly open a most recently closed

project.
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2.2.4. Adding Modules

After starting a Propel Builder project, you can add modules by dragging them from the IP Catalog view to the
Schematic view. The IP Catalog view comes with a large variety of modules for common use and some glue logic
modules as well, which can be found from the IP on Local tab (Figure 2.14). Click the IP on Server tab to find and
download more modules for specialized use.

1. (Optional) From the Propel Builder GUI IP Catalog area (Figure 2.14), choose the IP on Server tab. Select a desired

IP. Click the é Install button. After the IP is installed successfully, the new IP can be shown in the IP on Local tab.

IP on Local IF on Server -
EJ Module/IP on Local
* Module

k Architecture_Modules

» Processors_Controllers_and_Peripherals

] Verification |P
> P

k Processors_Controllers_and_Peripherals

k Security_Subsystermn

{} , — E-IJS-E }BUS - >0
=
rtl equation split concat invert
IF Catalog Design View

Figure 2.14. IP Catalog

2. From the IP on Local tab, select a desired IP, such as GPIO. Double-click the IP module or drag and drop the IP
module to the Schematic view. A Module/IP Block wizard pops up (Figure 2.15).
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4 Module/IP Block Wizard

Generate Component from IP gpio Version 1.4.1
This wizard will guide you through the configuration, generation and instantiation of this Module/IP. Enter the following
information to get started.

Component name:  gpiol

Create in:

Mext = Cancel

Figure 2.15. Module/IP Block Wizard — Generate Component from Module gpio Version 1.4.1

3. Enter a component name in the Component name area, such as gpio0. Click Next. Module/IP Block Wizard shows

the Configure Component from IP gpio page (Figure 2.16).

4. Module/IP Block Wizard

Configure Component from IP gpio Version 1.4.1
Set the following parameters to configure this component.

Diagram gpiod Configure gpio0:
=| Property Value
- General
MNumber of [/Q Lines [1-32] 1

Remove Tri-5tate Buffer
Initial Qutput Value (hex) [0 - FFFFFFFF] 0

gpio0 10 Direction (hex) [0 - FFFFFFFF] .

FAPB_S0

clk_i

resetn i

Interface APB

INT

gpio_io[0:0]

gpio

4 » | Mo DRC issues are found.

< Back Generate Cancel

Figure 2.16. Module/IP Block Wizard - Configure Component from IP Gpio Version 1.4.1
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(Optional) Click the Value field. You can enter a desired value for a property, check the checkbox to select a

property, or select a desired value from the dropdown menu for a property in the Value area. By changing the
value, the properties are thus configured. The property in gray is not configurable.

Click Generate. Module/IP Block wizard shows the Check Generated Result page (Figure 2.17).

4 Module/IP Block Wizard

Check Generated Result

Chedk the generated companent results in the panel below. Unchedk option ‘Tnsert to praject’ if vau
do not want to add this companent to your design,

IP: gpio Version: 1.4.1
Vendor; latticesemi.com
Language: Verilog

Generated files:

cfg: gpind.cfg
IP package file: gpiol.ipx

Component 'gpiod' is successfully generated.

IP-XACT _component: companent,xml
IP-XACT _design: design.xmi
black_box_verilog: rtl/gpio0_bb.v

template_verilog: misc/gpiol_tmpl.v
dependency_file: testhenchfdut_inst, v
dependency_file: testbench/fdut_params.v
template_vhdl: miscfgpio0_tmpl.vhd
top_level_verilog: rilfgpiod. v

Insert to project

< Back Finish
Figure 2.17. Module/IP Block Wizard - Check Generated Result
Select Insert to project (Figure 2.17) at the bottom of the Check Generate Result wizard.
Click Finish. The Define Instance dialog box opens (Figure 2.18).
s Define Instance 7 x
Instance Name: gpio0_inst
Instance Reference: gpio0:1.4.1
K Cancel
Figure 2.18. Design Instance Dialog Box
(Optional) Change the instance name, if desired. Space and special characters are not allowed.
Click OK. The schematic block for the module appears in the Schematic view (Figure 2.19).
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4y, Propel Builder [Ci/lscc/prepel/2.0/werkspace/EmptyProject/EmptyProject/EmptyProject.sbx] Device: LIFCL-40-98G400C - [m| X

File Edit View Design Tools Window Help

JEHR HCHN A GTHEOEHRRFES QQ QQ

IP Catalog mi Schematic Address Start Page
omox -
TF on Local 1P on Server T
g Module/IP on Local
* Module
3 Architecture_Modules
» Processors_Controllers_and_Peripherals i gp[oo_[p st
» 7 Verification IP clk_i > rf n
~ Ip
- Processors_Controllers_and_Peripherals R 31
© crio 141 T ’ rstn_i > — L JAPB_SO i
@ Rmsc-vMc 120 - INTR|+| -
@ RscvsMm 1007 — clk i L=
© uart g N -
3 Security_Subsystem gpio_lo =
w— resetn_i

) - -
{ ./.: nus-E }BUS :;-} -

rtl equation split concat invert
IF Catalog Design View i ¥ T
Tel Console O
% sbp_design close =

INFO - Finished: sbp design close
Finished: "sbp design close"™

% sbp_design open -name EmptyProject -path {C:/lscc/propel/2.0/workspace/EmptyProject/EmptyProject/EmptyProject.sbx}
% sbp_design config ip -vlnv {latticesemi.com:ip:gpic0:1.4.1} -meta_ loc {C:/Users/yzhao3/PropellPLocal/
latticesemi.com gpio_1.4.1} -cfg {C:/lscc/propel/2.0/workspace/EmptyProject/EmptyProject/lib/latticesemi.com/ip/
gpiod/1.4.1/gpiod.cfg}

% sbp add component -vlnv {latticesemi.com:ip:gpicO:1.4.1} -name {gpicl _inst}

L]

Figure 2.19. Propel Builder Schematic View Shows the Module Instance

2.2.5. Adding Glue Logic

Propel 2.0 builder supports glue logic modules as well as IP modules. You can add glue logic modules by dragging them
from the IP Catalog view (Figure 2.20) to the Schematic view.
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IF on Local IF on Server h =
1 Module/IP on Local
* Module

k |'f'| Architecture_Maodules
k |'f'| Processors_Controllers_and_Peripherals
¥ [ Verification IP

> P
k |'f'| Processors_Controllers_and_Peripherals
¥ | Security_Subsystem

S
_{}E j — aus-E }nus ~I:>«-,—
rtl equation split concat invert
e
IP Catalog Design View

Figure 2.20. IP Catalog

e Concat

a. From the IP Catalog, select the concat module. Double-click the concat module or drag and drop concat
module to the Schematic view. A Glue Logic wizard (Figure 2.21) pops up.
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Logic Diagram Configuration

RHS:  BUS[5:0]
LHS: | 5.4
) B[3:1]
A[5:4]
B[3:1]

C[0]

col

BU5[5 :O] Add Remave

QK Cancel

Figure 2.21. Glue Logic for Concat Module

Click the RHS field to change the default right-hand side bus width to a desired one. Click the LHS field to

change the default left-hand side bus width to a desired one. Click the Add button to add LHS (Left-

hand Side). Click the Remave button to remove LHS (Left-hand Side). You can only add or remove LHS but

not RHS. LHS and RHS are thus configured.

Click OK. The schematic block for the concat module in red appears in the Schematic view (Figure 2.22).
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Schematic Address Start Page

clk i —

rstn | B[3:1]] BUS[5:0]

Figure 2.22. Schematic View Shows a Concat Module

e Equation

a. From the IP Catalog, select the equation module. Double-click the equation module, or drag and drop the
equation module to the Schematic view. A Glue Logic wizard (Figure 2.23) pops up.
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% Glue Logic ? ot
Logic Diagram Configuration
Module Mame:  eguation_module
Expression: O= A &IB
A € uation_module
al 0
-
4 [
oK Cancel

Figure 2.23. Glue Logic Wizard for Equation Module

b. Click the Module Name field to change the default value to a desired name. Click the Expression field to
change the default expression to a desired one. The expression supports and (&), or (|), negation (!). The
module name and expression are thus configured.

c. Click OK. The schematic block for the equation module in red appears in the Schematic view (Figure 2.24).
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equation_module_inst
O
G
1 »

Figure 2.24. Schematic View Shows an Equation Module

e Invert

a. From the IP Catalog, select the invert module. Double-click the invert module, or drag and drop invert module
to the Schematic view. The schematic block for the invert module in red appears in the Schematic view
(Figure 2.25).
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Schematic Address Start Page

invert

Figure 2.25. Schematic View Shows the Invert Module

e Ril

a. From the IP Catalog, select the rtl module. Double-click the rtl module or drag and drop the rtl module to the
Schematic view. A Glue Logic wizard (Figure 2.26) pops up.
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%, Glue Logic ?

Loagic Diagram Configuration

IJse Existing File:

Rt:  module rii_meodule {input rstn,output out);
endmodule

rtl_module

—rstn out—

QK Cancel

Figure 2.26. Glue Logic Wizard for Rtl Module

b. You can edit your own rtl module in the Rtl area by entering the rtl module function.

c. Or, you can use an existing rtl module by checking the Use Existing File checkbox. After checking the Use
Existing File checkbox (Figure 2.27), browse to find the existing RTL module file path from the Path filed. And,
check the CopyToDesign checkbox, if you want to copy the rtl module to the design.
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., Glue Logic ? >
Logic Diagram Configuration
IUse Existing File:
Path: rkspaceftest_module1.v .
CopyToDesign:
nv
A[2:0]f—
—1bb[10:8] Bl
C -
4 4
CK Cancel

Figure 2.27. Existing Rtl Module Configuration

d. Click OK. The schematic block for the rtl module in red appears in the Schematic view (Figure 2.28).
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inv_inst
A[2:0] p—
mm bb[10:8] B fr—
C ——
1 » i

Figure 2.28. Schematic View Shows the Custom Rtl Module

Note: Currently, Rtl Module only supports Verilog HDL.
e Split

a. From the IP Catalog, select the split module. Double-click the split module, or drag and drop the split module
to the Schematic view. A Glue Logic wizard (Figure 2.29) pops up.
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Logic Diagram Configuration
1| s [oustsa
RAS: | a5
B[3:1]
- cle]
ﬁ' 5 : 4] Add Remove
BUS[5:0](B[3:1]
et
C[0]
‘ i
Ok Cancel

Figure 2.29. Glue Logic Wizard for Split Module

Click LHS field to change the default left-hand side bus widths to a desired one. Click RHS field to change the

default right-hand side bit width to a desired one. Click the Add button to add an RHS. Click the
Remove button to remove an RHS. You can only add or remove RHS but not LHS. LHS and RHS are thus
configured.

Click OK. The schematic block for the split module in red appears in the Schematic view (Figure 2.30).
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]
C[O]
[ » "

Figure 2.30. Schematic View Shows Split Module

2.2.6. Undo/Redo

Propel 2.0 Builder supports one-level undo/redo. You can click the Undo icon from Propel Builder Toolbar to go back to
last action. Click the Redo icon from Propel Builder Toolbar to recover last undo action.

)

e Undo: Choose Edit > Undo from the Lattice Propel Builder Menu bar. Or, click the Undo icon from
Propel Builder GUI Toolbar.
e Redo: Choose Edit > @ Redo from the Lattice Propel Builder Menu bar. Or, click the Redo icon from

Propel Builder Toolbar.

Note: Currently, Propel 2.0 Builder only supports single undo/redo.

2.2.7. Working with the Schematic View

You can make changes in the Schematic view including automatic layout to clean up the display, moving, resizing,
renaming blocks manually, highlighting objects and zooming the display in and out.

e Toview signal list of block:

ry
1 I

Click the plus signl--!--l of the desired block to see what signals it contains. The plus sign changes to a negative sign
=1 | F |

C—J and shows the signal list as shown in Figure 2.31. Click the negative signLTJI to close the expanded bus. The
schematic returns to the previous form.
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gpio0_inst
- -
—~{I—APB_S0
— pPADDR[5:0]
— PpPENABLE
—~ <«PRDATA[31:0]
— 4PREADY .
INTRi=i =
—  PPSELx e
gpio_io|—
— <«PS5LVERR
—~{ PPWDATA[31:0]
— PPWRITE
—clk_i
—resetn_i
A
Figure 2.31. Signal List of Modules
e To select one or more objects:

Select one object or more objects in one of the following ways:
e Click on the object in the Schematic view. The selected object turns to red (Figure 2.32).

36
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. Propel Builder [C:/lscc/propel/2.0/workspace/EmptyProject/EmptyProject/EmptyProject.sbx] Device: LIFCL-40-3BG400C - O X
File Edit View Design Tools Window Help
s B 9 A @A NGEe T QQaa
IP Catalog o Schematic Address Start Page
= g
W A o= -
IP on Local IP on Server T
Q Module/IP on Local
~ Module
3 Architecture_Modules
» Processors_Controllers_and_Peripherals . g 3'00_' nst
» [ Verification IP clk_i r ~
> P
- Processors_Controllers_and_Peripherals . 31
@ 6pio 141 = rstn_i > ml | |APE_SO
= = rya
@ rRscvmc 120 INTR e} o
@ Rsc-vsm 100 ok L
© uarr @ -
3 Security_Subsystem gpio_lo
- resetn_i

: = -
OF f= wf Jw |

rtl equation split concat invert
IP Catalog Design View i v hd
Tel Console [m|
% sbp_design close -

INFO - Finished: sbp design close
Finished: "sbp_design close"

% sbp_design open -name EmptyProject -path {C:/lscc/propel/2.0/workspace/EmptyProject/EmptyProject/EmptyProject.sbx}
% sbp_design config ip -vlnv {latticesemi.com:ip:gpioc0:1.4.1} -meta loc {C:/Users/yzhao3/PropelIlPLocal/
latticesemi.com gpio_l.4.1} -cfg {C:/lscc/propel/2.0/workspace/EmptyProject/EmptyProject/lib/latticesemi.com/ip/
gpio0/1.4.1/gpio0.cEg}

% sbp_ add component -vinv {latticesemi.com:ip:gpic0:1.4.1} -name {gpicO_inst}

%

Figure 2.32. Select Object
e  Ctrl-click or Shift-click in the Schematic view to select more than one objects.

e Click the Area_selecticon* k: from the Propel Builder Toolbar. Click and drag to draw a selection rectangle
around the modules and ports in the Schematic view. Click the icon again to turn off the Area_select mode.

e From the Schematic view, Right-click and choose Select All or press Ctrl-A to select all of the objects.

Note: Ctrl-click or Shift-click on the object in the Schematic view can also de-select the object while leaving the
others selected.

e Tore-arrange the schematic:

Propel Builder allows re-arranging the objects in the schematic view. You can re-arrange modules and the ports.
Drag objects to re-arrange the schematic. Propel Builder has rules for placing objects so as to adjust the schematic
in an organized arrangement.

a. Select the desired modules (one or more modules can be dragged at the same time) or ports (one or more
ports can be dragged at the same time).

b. Click on the selected items and drag it to the desired location.
c. Release the mouse button.

Note: The selected objects can be moved to the specified location, or as near as the rules allow. Other objects in
the schematic can also be moved to accommodate the selected objects’ new location.
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To bring selected objects to the center of the Schematic view using the Locate Object mode:

7™
e

a. Click the Locate Object icon “:” from the Propel Builder Toolbar. The background turns to dark gray.

b. Select the object in the List view of the Design View. The selected object is in the center of the Schematic View

(Figure 2.33).

. Propel Builder [Ciflscc, 2 p ptyProjec/EmptyProj ptyProjec.sby] Device: LIFCL-40-9BG400C - o X

File Edit View Design Tools Window Help

s R 9D & @ MENEHE-: o QaQae

Design View o Schematic Address Start Page

v 1F EmptyProjec &
» 27 Ports
~ { Instances

v 1F gpiol_inst
~ | Compenents gpio0_inst
I gpic0:1.4.1 ( ~

ry
— |+|AP5730
L= ry
INTR| | j—

>
B | T

clk_i

rstn_i

w— resetn_|
Properties

Name: | gpiod_inst

Type: Instance \ J
Path: EmptyProjec/gpio0_inst
VLNV: latticesemi,comip:gpio0:1.4.1

IP Catalog Design View a D
Tcl Console [a]
% sbp_design open -name EmptyProjec -path {C:/lscc/propel/2.0/workspace/EmptyProjec/EmptyProjec/EmptyProjec.sbx}
% sbp_design config_ip -vlnv {latticesemi.com:ip:gpio0:1.4.1} -meta_loc {C:/Users/yzhao3/PropellPLocal/latticesemi.com ip gpio_1.4.1} -cfg {C:/lsce/propel/2.0/
workspace/EnptyProjec/EmptyProjec/lib/latticeseni.con/ip/gpio0/1.4.1/gpio0. cfg}
% sbp_add_component -vlnv {latticesemi.com:ip:gpio0:1.4.1} -name {gpio0_inst}
% sbp_design undo

% sbp_design redo
%

Figure 2.33. Locate Objects

To automatically simplify the layout:
e Right-click anywhere in the Schematic view and choose Relayout.

To duplicate a module:

e Select the desired module and click Clone . Or, right-click on the module and choose Clone . A copy of

the schematic block appears with a new instance name (Figure 2.34).

gpio0_inst gpic0_inst_0
' N ' N

= ig=iAPB_SO _ = i1 APB_SO _
- INTR ufe] e B INTR ] e
. L= . L=
—clk_i —clk i
gpio_io— gpio_iop—
—resetn_i —{resetn_i

. J . J

Figure 2.34. Duplicate a Module
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To restore a deleted module:
a. Inthe List view of the Design View (Figure 2.35), go to the Components folder. The deleted module can still be
found in the List view in plain text. Those not deleted are shown in bold-faced text.

-

-

Design View
+ 1 EmptyProject

Sc- Ports

[ clici

[ rstn_i
EE'—FF Instances
v 1F gpiolinst
v 1 gpiclinst 0
r ﬂ system_inst
r ﬂ cpul_inst

A Components

@ cpu(:1.0.0
|| gpio0:1.4.1
[/ gpio0_0:1.4.1
@ system:1.0.2

|

C: flsccfpropel (2.0 fworkspace [EmptyProject/EmptyProject/EmptyProject. shx

Properties
Mame:
Type: Instance
Path: EmptyProject
VLMY  lattice:systembuilder :EmptyProject: 1.0
File:
4
IF Catalog Design View

Figure 2.35. Design View

b. Right-click on the desired component and choose Instantiate. The Define Instance dialog box (Figure 2.36)

open.

4 Define Instance

Instance Mame: apbl_inst
Instance Reference: apb0:1.0.6

Ok

Cancel

Figure 2.36. Define Instance Dialog Box
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c. Enter a name for the new instance.

d. Click OK. The module appears in the Schematic view and the List view of Design Info, and the component
name is bold-faced.

To reconfigure a module:

a. Double-click the module, or right-click the module. Choose Reconfig. The Module/IP Block wizard (Figure 2.37)
opens.

. Module/IP Block Wizard X

Configure Component from Module apb_interconnect Version 1.0.6
Set the following parameters to configure this component.

Diagram apbd Configure IP
General Main Settings Master Priority Settings
Property Walue
~ General
Total APB Masters [1 - 32] 2
Total APB Slaves [1- 32] 2
Master Address Width(bits) 32
apb0
Data Bus Width(bits) 32
—[4HArB_s00
—-ArB_S01  APB_ MO0~
—{apb_pclk_i APB_MO14H~
—apb_presetn_i

apb_interconnect

1 4 Mo DRC issues are found.

Generate Cancel

Figure 2.37. Module/IP Block Wizard — Configure Component

b. Configure component (including General property, Main Settings and Mater Priority Settings) at Configure IP
table in the Module/IP Block Wizard. Click Generate to generate the module as usual. The schematic block for
the module changes to match the new configuration.

Note: For an SoC design, if the init file (mem file) of System Memory module instance is updated in a C project, the
initialization section of the system memory module instance should be re-configured. Or, use the ECO flow to
update the information. Refer to the Diamond online help for more on how to use an ECO flow.

To resize module blocks:
a. Select the desired module block. The block is highlighted in red with black corners (Figure 2.38).

40
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L |

Figure 2.38. Select Module

b. Click and drag one of the corners to change the size and shape of the block.
c. Release the mouse button. All the other objects move to make room for this block.
Note: Right-click the module block and choose Unresize Instance to restore the size of the module block.

e There are a variety of methods to zoom within the Schematic view, including toolbar commands and dragging in
the Schematic view.

The following commands are available from the Propel Builder Toolbar.

Zoom In (Ctrl++) @ — enlarges the view of the entire layout.

Zoom Out (Ctrl+-) Q — reduces the view of the entire layout.

e Zoom Fit — reduces or enlarges the entire layout so that it fits inside the window.
l/b\
e ZoomTo R _ enlarges the size of one or more selected objects on the layout and fills the window with
selection.

Note: The mouse wheel provides a finer zoom control by rolling the mouse wheel forward to zoom in and

backward to zoom out while pressing the Ctrl key.

To zoom by holding the mouse button and dragging.

e Tozoom to fit the window, drag up and to the left. The image adjusts to fill the window.

e Tozoom out, drag up and to the right. The dragging distance determines the amount of zoom. The image is
reduced and centered in the window.

e« Tozoom in, drag down and to the left. The dragging distance determines the amount of zoom. The image is
enlarged and centered in the window.

e« Tozoomin in a specific area, start at the upper-left corner of the area and drag to the lower-right corner of the
area. The area that dragging across is adjusted to fill the window.

Note: Make sure that the Area_select icon o is not selected in the Toolbar. If you need to use Area_select and
zoom by dragging frequently, choose Design > Options from Propel Builder menu bar. The Options Dialog opens
(Figure 2.39). Select Use right mouse button for zooming actions and click OK. Then you can select an instance

i

using the left mouse button, zoom in or zoom out using the right mouse button, and the Area_select icon
disappears from the Propel Builder Toolbar.
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4. Options ? x
Themes: Light -
General Color Metwork Settings Directories

Use right mouse button for zooming actions

Set Default

K Cancel Apply

Figure 2.39. Options Dialog

To move the schematic image within the Schematic view by panning and scrolling.

e To pan the image: Hold down the Ctrl key and the left mouse button while dragging the image.

e To scroll vertically: Rotate the mouse wheel. Or, click in the vertical scroll bar.

e To scroll horizontally: Hold down the Shift key and rotate the mouse wheel. Or, click in the horizontal scroll bar.

To show the connectivity of a module: right-click the module and choose Show connectivity. All nets connected to
the module, all pins and ports connected to the nets are highlighted (Figure 2.40).

42
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o iR g ok fu bol_brossn |
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Name: | cou_inst

2hbl2apb0_inst

+

Type: Instance
Path: HelloWiorld/cpud_inst
VLNV latticesemi, comsip:cpu0: 1,1.0

Design View 1P Catalog a G

Tel Console
% sbp_design open -name HelloWorld -path {C:/lscc/propel/2.0/workspace/HslloWorld/HelloWorld/HelloWorld.sbxi
s

Figure 2.40. Show Connectivity of the Module

<,
To highlight an object: select an object and click Highlight ‘:4’ or, right-click the object and choose Highlight

2 2
. The object is highlighted in blue (Figure 2.41). Click Highlight again. You can remove highlighting.

pio0_inst

Figure 2.41. Highlight an Object

To change the name of an object:

a. Select the object from the List view of Design View. Information of the selected object is shown in the
Properties area (Figure 2.42).

 / Lattice Propel 2.0 Builder
= LATTICE P :
User Guide
“, Propel Builder [C:/lscc/propel/2. p: HelloWorld/HelloWorld/HelloWorld.sbx] Device: LIFCL-40-3BG400C - O X
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Properties
MName: gpiol_inst

Type: Instance
Path: EmptyProject/gpiol_inst
YLMY:  |atticesemi.com:ip:gpio0:1.4. 1

IP Catalog Design View

Figure 2.42. Object Properties

b. Change the name and click Enter. The name changes in the Schematic view and List view of Design Info.
e To print a schematic:
a. Choose File > Print Preview. The Print Preview window (Figure 2.43) opens.

&, Print Preview: Schematic ? X

HE »=]Q @& BE <« 019+ JEHE D&

e 51 wem o veT:
4190 S AEL M1 DA
s T R
JEnl e rmdn o

Figure 2.43. Print Preview

b. Expand the Print Preview window to the desired size.

c. Click the Page Setup button :r— and adjust the paper size and margins, if necessary.

d. Click the Print button
e. Adjust the printer settings, if necessary. Click Print.
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2.2.8. Connecting Modules

You can connect the pins of modules to other modules or to top-level ports by dragging a line between them or by
selecting connection points, or by assigning a constant value to an input pin or bus. Propel Builder does not allow

obvious inappropriate connections, such as a connection between two output pins or mismatched buses.

e To connect modules by drawing:

a. Move the cursor to a pin or port. The cursor changes to a pencil icon 1#. Click and hold while dragging to
another pin, port, or net. An allowed pin or port shows a green check-mark when you hover over it

(Figure 2.44). An allowed net becomes bold when you hover over it (Figure 2.45).

apb0_inst
g N
i=f=1APB_S00
=== rz- _________._%;
I _!_J APB_S01 APB_MUOL -!- g
apb_pclk_i APB_MO1{afn] e
- L—d
apb_presetn i
v
Figure 2.44. Draw a Pin or a Port
cpu0_inst
- 3
—FRIRQ_SO
—FRIRQ_S1
—FRIRQ_S2
— [—HIRQ_S3 AH BL_MO_INSTR[:—}-] -
—FRIRQ_54 AHBL_M;TDATAE
—HHIRQ_S5 TIMER_IRQ_MOFH]
— H—_}IRQ_SG ~ system_resetn_o
_=FRIRQ_S7
clk_i dk_i
rstn_i rst_n_i
_ J

b. Click on the pin, port, or net that you want to connect to. If the connection is allowed, a line appears

v

gpic0_inst

g
i==|APB S0 -
ke INTR{=]
. L=l
clk_i

io_io
resetn i gpie—

sysmemO_inst
/S

H—]AH BL_S0
— E_'-EAH BL_S1
_—ahbl_hclk_i
ahbl_hresetn_i

Figure 2.45. Draw Nets

connecting the two objects. Propel Builder creates a path around other objects.

c. You can connect multiple ports once. When more than one port are selected (Figure 2.46), click connect =

from the right-click menu to implement it.
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hbizapbo_inst
shblo_inst L
FF AHBL_SO —
w5 HFAHBL_S00 . R — b2
red_i[ o “hb bl s AHEL_MOOGE i APB_MOZE — led_o[7:0]
o e, | AHEL MOLEF £_n_
apbl_inst
cho inst FFM)B_mAPB Moo
apb_pclk i =
HFIRQ_SEBBL_MO_INSTRAF ... APB_MOLEF
FFIRG_SHEL M1 DATATF T
ki TIMER_IRQ_MOHF =
—frst_n_i Ty 0
oscl_inst

gpicd_inst

zhbl_hresatn_

uartl_inst

FAPE_S0
ki INT_MORF
st n o

Figure 2.46. Select More than One Ports

d. When the net is complete, right-click to leave the drawing mode.
e To connect modules by selecting points:

a. Select the pins, ports, and nets that you want to connect.

o—

]

b. Right-click one of the selected objects. Choose Connect — .
e To assign a constant value to an input pin:

a. Select the desired pin and right-click the pin. Choose Assign Constant Value (Figure 2.47). A small dialog box
appears (Figure 2.48).
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sysmemO_inst

r

ua * Highlight

rst n_i

ahbl

1%

ahbl_

r
L'l'__}‘ﬁlPE_E = Connect

~———{ FIAHBL_S0
= IHAHBL_S1

b inm ot

Copy Full Path

Assign Constant Value

[+ Export
Create Port
Auto connect clk rst
Create Comment

5 Validate Design

Select All
Relayout

Figure 2.47. Action Menu of Right-clicking an Input Pin

sysmem_inst

MRAHBL_S0
MRAHBL_S1

ahbl_hclk

___Assign constant value:

ob v X

Figure 2.48. Dialog Box of Assigning Constant Value to an Input Pin

b. Enter the desired value. To erase the value and start over, click X. For all buses (more than one pin), the
format is hexadecimal. Make sure the value fits the number of pins in the bus. For example, a 3-pin bus can

accept 0-7, but not 8.

Usually, disconnecting modules just means deleting a net. If the net has multiple branches, just delete one branch,

leaving the rest of the nets intact.

e Todisconnect one branch of a net, right-click the pin of that branch and choose ~ Disconnect. The branch

going to that pin disappears.

e To disconnect a whole net, right-click the net and choose Delete. The whole net is deleted.
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2.2.9. Creating Top-Level Ports
With multiple modules in a Propel Builder project, top-level ports need to be created for a complete Propel Builder
module. You can create a top-level port either manually or automatically.
For input ports that connect to more than one pin, such as for clock and reset signals, the manual way is more
convenient than the automatic way. If the port names automatically-generated need to be changed, the manual way is
better.
For other pins, the automatic way is usually preferred. The automatic way enables you to create the appropriate port
type and connect net simultaneously. The automatic way can also create multiple ports at the same time.
The automatic way of creating ports is the most effective. If all the modules are selected, Propel Builder can
automatically create ports for all the remaining unconnected pins for selected modules in one step.
e To create a port for a pin or bus manually:

a. Right-click in the Schematic view, and choose Create Port. The Create Port dialog box pops up (Figure 2.49).

%, Create Port ? >
Mame: input_paort
Direction: Input 7
Type: General -
Bus Options:

Ok Cancel

Figure 2.49. Create Port Dialog Box

b. Enter a name for the port in the Name field.
Choose a direction for the port, such as Input in the Direction field.
d. Choose the port type from the Type field. The default type is General.

e. (Optional) Select the Bus Options. Enter the number for the most significant bit (MSB) and the least significant
bit (LSB). These two options define the bus width.

f.  Click OK. The port appears. Figure 2.50 shows an input port, port name of which is on the left. Figure 2.51
shows an output port and an inout port, port names of which are on the right.

input_port [ >

Figure 2.50. Input Port

{_> Inout_port
[ output_port

Figure 2.51. Output Port and Inout Port

g. Connect the port to the module pins. Refer to the Connecting Modules section for more details.
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e Tocreate ports automatically:

a. Select the pins that are to be connected to the top-level ports. All the pins in a module can be selected by
clicking its block. Any pins that are already connected to a net or a constant value are skipped.

b. Right-click on one of the selected pins, interfaces or modules, and choose

"Export. The selected pins are

extended by lines to new top-level port symbols. The names of the ports and nets are added to the List view.

Zoom out or scroll the image in the Schematic view to see the new ports.

c. Portor net names can be changed, if needed.

2.2.10. Adjusting Address Spaces

The Address view shows the base address, size of the address segment, and the end address for each leaf
memory-mapped slave connection in the Propel Builder project. Propel Builder can automatically assign address
values, while the base address value can be changed manually. The ranges are set when the modules are configured.

The end addresses are calculated.

The Lock option on each address space prevents Auto Assign from changing the base address value. The Lock option is
selected automatically when you manually change the address value. To reset the address space, clear the Lock option

before clicking the Auto Assign icon.

Note: There is no Lock option on LocalMemory. The value of the base address can always be changed, while Auto
Assign does not reset it to its original value.

1. Inthe Propel Builder main window, click the Address tab. The Address view (Figure 2.52) shows.

Schematic Address Start Page
Cell Base Address
* cpul_inst
¥ LocalMemory
cpull_inst/pic_timer_registers OxFFFFO000
> cpul_inst/AHBL_MO_INSTR(32 address bits: 4G)
sysmem{_inst/AHBL_S0 0x00000000
~ cpul_inst/AHBL_M1_DATA(32 address bits: 4G)

gpiol_inst/APB_S0O 0x00008400
sysmem{_inst/AHBL_S1 0x00000000
uart0_inst/APB_S0 000008000

2. (Optional) Set or clear the Lock options as desired in Address view.

In the Propel Builder Toolbar, click Auto Assign

Range

2K

32K

End Address

OxFFFFOTFF

0 00007FFF

0x000087FF

0x00007FFF
0x000083FF

Figure 2.52. Address View

LA

Lock

»

0x00000000

0x00007FFF
0x00008000

0x000083FF
0x00003400

0x000087FF

gpio0_inst/APE_S0

. Default address values appear in Address view.

4. (Optional) Double-click the base address in Address view (Figure 2.53). Type the new value and press Enter. Values
must align with 1K boundaries, such as 0x00000400, 0x00000800, or 0x00000C00. The end address value changes

based on the new value. The Lock option is selected automatically at this time.
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Schematic Address Start Page
Cell Base Address Range End Address Lock
~* cpul_inst
~ LocalMemory OxFFFFO000

cpul_inst/pic_timer_registers L5335/ 2K OxFFFFOTFF

¥ cpul_inst/AHBL_MO_INSTR(32 address bits: 4G)

sysmem{_inst/AHBL_S0 000000000 32K 0x00007FFF [
¥ cpul_inst/AHBL_M1_DATA(32 address bits: 4G)
gpiol_inst/APB_S0 000008400 1K OxD0008TFF [
sysmem{_inst/AHBL_51 0x00000000 32K 000007 FFF
uart(_inst/APB_S0 000008000 1K 0x000083FF [
OxFFFFO7FF
4 ]

Figure 2.53. Edit Base Address

Note: If there is a conflict of a related address space, it is shown in red in the graphic.

2.2.11.Validating the Design

The design rule check (DRC) can be run at any time. This checks whether or not there is any illegal connection or
overlapping address space.

To perform the design rule check:

1. From the toolbar of the Propel Builder main window, click the Validate Design icon @ . The DRC results appear in
the Tcl Console.

2.2.12.Generating the RTL file

The final step for creating a Propel Builder module is to generate a .sbx file, which defines a Propel Builder project, an
RTL file, and the instantiation templates. The RTL file includes the Verilog code for the module. The instantiation
templates have Verilog and VHDL code to help instantiate the Propel Builder module in a design.

e  From the toolbar of the Propel Builder main window, click the Generate icon r':l . This step also saves the Propel

Builder design and runs the design rules check (DRC).

e  From the toolbar of the Propel Builder main window, click the Generate Memory Report icon %' . The SoC
design memory information is generated. The memory report folder (mem_report) is generated. All design
memory information is shown in detail in the memory report files. The Memory Report files are in HTML format
(Figure 2.54).

20C Memory Map for S0C : Project Summary Page
HelloWorld Generated by Lattice Propel Software S0C Verification Engine
Copyright (C) 1992-2021 Lattice Semiconductor Corporation. All Rights
Table of Contents Reserved.

Project Summary

Project Summary

Detailed Memory Map

- = Project Name Family Device PartName Speed Language
- - R mmm PR - LIFCL-40- 9 High- : -

C CL-40 -_— i
_ HelloWorld LIFCL LIFCL-40 9BGA00T Porformance 0.9 (verilog

Figure 2.54. Memory Report
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2.2.13.Opening Project in Diamond or Radiant

In a complete SoC project, a Diamond or Radiant project can be created including a Propel Builder design, and after
that the SoC project can be opened in Diamond or Radiant software. According to device in the SoC project, Propel
Builder can launch Diamond or Radiant software accordingly. If the device is LCMX0O3D, MachXO3L, MachXO3LF,

*
MachX02 LFMNX, the Diamond icon

Radiant icon

software directly after template SoC project is created.
e To launch Diamond software:

a. Click the Diamond icon

from the Propel Builder toolbar.

is shown in the Builder GUI Toolbar. If the device is LIFCL or LFD2NX, the

is shown in the Builder GUI Toolbar. For a template SoC project, you can launch Diamond or Radiant

b. Lattice Diamond is launched with a Diamond project generated for SoC at background (Figure 2.55).

Synthesis Constraint Files
v LPF Constraint Files

[ Sentrylpf

Del_ﬂug Files Software Upgrade Recommended

Seript Files Currently running Lattice Dismond software version:
Analysis Files

3.11.0.396.4
Programming Files Diamond updates available:

[T Y

<

*# Lattice Diamond - Start Page - O *
File Edit View Project Design Process Tools Window Help
BA-E-Hd 8 radih @ERQQAQ @ B EDO
c o = , HH M @ b = . =
PECHESEGSCEEGR=LUscBRY RREEEE @
File List 8 X| [ Start Page ] Reports 5 x
v @ Sentry
LCMX03D-9400HC-6BG484C _
= . Project: User Guides Reference Guides ~
v Strategies @ o
[} Area pen.. Lattice Diamond Releaze Notes Strategy
r} /O Assistant Ea lew Lattice Diamond User Guide Constraints
% Quick {5 Import ispLEVER Project... Lattice Synthesis Engine for Hardware How-To
. N Diamond User Guide
E® Timing Recent Proj X Lattice Modules
Strategy1 @ Sentry : Managing Projects FPGA Libraries (HTML version)
g EE impl1 @ test o Platfa.rm Designer User Guide FPGA Libraries (PDF version)
v Input Files St_sentry Entering the Design Command Line
m Sentry/Sentry_Top.v @ pfr3_hw Clarity Designer User Manual Td Commands
M Sentry/Sentry.v [ tests Simulating the Design

Applying Design Constraints
Implementing the Design
Using Incremental Design Flow
Analyzing Static Timing
Analyzing Power Consumption
Analyzing Signal Integrity
Programming the FRGA

Programming Tools User Guide

Glossary

Design Tool Reference
Tutorials

Lattice Diamond Tuterial

Lattice Synthesis Engine Tutorial
FPGA Design Guide

Design Planning

HDL Coding Guidelines

Timmi 1

File List Process Hierarchy

Td Console

> source "C:/lscc/propel/2.0/workspace/Sentry/diamond setup template.tcl™
>

Td Console Output Error*® Warning* Info*

Ready

Mem Usage: 117,976 K

Figure 2.55. Diamond Project

c. (Optional) From the File List view of Diamond:

« modify the top-level RTL file (<proj_name>_Top.v) to match the SoC design, presupposition of which is

that there is a top-level RTL file in your SoC design.

e create a top-level RTL file (<proj_name>_Top.v) to match the SoC design, if the SoC design is created from
an Empty Project template and there is no top-level RTL file in your SoC design.

d. (Optional) Modify LPF constraint file (<proj_name>.Ipf) to match the SoC design, if you have modified the SoC
design. This step is a must to the SoC design that is created from Empty Project template.

e. Switch to Process view of the Diamond project (Figure 2.56). Make sure at least one programming file (IBIS
Model, Verilog Simulation File, VHDL Simulation File, Bitstream File, or JEDEC file) is selected in the Export
Files section. Available programming files can be different upon specific device included.
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Update Rel Programming the FPGA g a
ate Release ideli
< Frogramming Tools User Guide HOL Coding Guidelines ©
Timmi 1
File List Process Hierarchy-——Post Map Resources
Qutput g x
Initialized UFM Pages: 0 Page.

Jedec File [0]: Sentry impll.fea
Jedec File [1]: Sentry_impll_a.jed
Total CPU Time: 2 secs

Total REAL Time: 3 seca

Peak Memory Usage: 212 MB

Done: completed successfully

Td Console Output Error Warning*® Info®

Ready

Mem Usage: 131,364 K

f.  Right-click Export Files, and choose Run

used in the Diamond Prog

Figure 2.56. Generate Programming Files

rammer.

Note: Refer to the Diamond online help for more details of the Diamond project.

To launch Radiant software:

a. Click the Radiant icon

from the Propel Builder toolbar.

. The programming file is generated. The programming file can be

b. Lattice Radiant is launched with a Radiant project generated for SoC at background (Figure 2.57).
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Figure 2.57. Radiant Project

c. (Optional) From the File List view of Radiant:
« modify the top-level RTL file (<proj_name>_Top.v) to match the SoC design, presupposition of which is
that there is a top-level RTL file in your SoC design; or
+ create a top-level RTL file (<proj_name>_Top.v) to match the SoC design, if the SoC design is created from
an Empty Project template and there is no top-level RTL file in your SoC design.

d. (Optional) Modify pdc constraint file (<proj_name>.pdc) to match the SoC design, if you have modified the
SoC design. This step is a must to the SoC design that is created from Empty Project template.

e. Click Run all. The Programming file is generated. It can be used in the Radiant Programmer.
Note: Refer to the Radiant online help for more details of the Radiant project.

2.2.14.Launching SDK

After an SoC design is completed, Propel SDK can be launched in Propel Builder for software development. For
template SoC project, you can launch SDK directly by clicking Run Propel icon from Propel Builder toolbar after
template SoC project created.

1. Click the Run Propelicon = from the Propel Builder GUI Toolbar. Lattice Propel Launcher (Figure 2.58) opens.
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ﬁ Lattice Propel Launcher

Select a directory as workspace

Lattice Propel uses the workspace directory to store its preferences and development artifacts.

e Browse...

Workspace: Q‘

[] Use this as the default and do not ask again

» Recent Workspaces

Figure 2.58. Lattice Propel Launcher Wizard

2. Click Launch. Propel SDK GUI opens and the C Project wizard (Figure 2.59) pops up for loading the system and the
board support package (BSP) to create a C/C++ project.

ﬁ C/C++ Project O it

Load system and bsp

Correct system environment file and get toclchain parameter

Select systemn envirenment file and bsp package

System enw: | Ciflscc/workspace/HelloWorld/HelloWorld/../sge/sys_envaml -~ Browse...

Select processor core to create C/C++ Project

Core selected: | cpul_inst
Project type: | C w
Systemn information

Device Family CPU Mame Instance Mame

LIFCL FISCV_MC cpul_inst

® < Back Finish Cancel

Figure 2.59. Propel SDK GUI and C/C++ Project Wizard
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3. Click Next. The C/C++ project dialog (Figure 2.60) opens.

0% C/C++ Project O x

C/C++ Project
Create C/C++ project of selected type

Project name: | HelloWorld_C

Use default location
Location: | Chlsechpropel2.0\workspace\HelloWorld_C Browse...

Choose file systerm: | default

Project type: Toolchains:

» [= GNU Autotools RISC-V Cross GCC
w = Executable

& Empty Project
& Lattice C/C++ Project
& Hello World RISC-V C Project
& Helle World AMSI C Project
» [2= Shared Library
» [= Static Library
» = Makefile project

Show project types and toclchains only if they are supported on the platform

@ < Back Finish Cancel

Figure 2.60. Create C/C++ Project

4. Enter a project name in the Project Name field, such as HelloWorld_C. Click Next. The Lattice toolchain setting
dialog opens (Figure 2.61).
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{1 C/C++ Project O >

Lattice toolchain setting

Configuration: | Debug w

Lib Setting  C/C++ Compiler C/C++ Linker
() No default libraries(-nodefaultlibs)

() Newlib
(@ Mewlib-nano

@ Next » Finish Cancel

Figure 2.61. Lattice Toolchain Setting Dialog

5. Click Finish. The C/C++ project is created and is displayed using the C/C++ perspective. A perspective is a collection
of tool views for a particular purpose. The C/C++ perspective is for creating C/C++ programs.

Note: Refer to Lattice Propel 2.0 SDK User Guide (FPGA-UG-02127) for more details on how to create a C/C++ project
and develop the C/C++ project in Propel SDK.

2.3. Verification Project Design Flow
2.3.1. Creating a Verification Project

1. Choose File > New Design from the Lattice Propel Builder Menu Bar. The Create System Design wizard opens
(Figure 2.62).
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. Create System Design *

Design Information
Enter a name for your design and specify a directory where the design files wil be stored.

Project:

Type: SoC Verification -

Mame: Verification_Project

Location: | C:flsccfpropel /2.0 /waorkspace * | | Browse...

Create Project at C: flsccfpropel /2.0 fwarkspace Merification_Project

Mext = Cancel

Figure 2.62. Create System Design — Design Information Wizard

Choose SoC Verification from the Type field.

Enter a project name in the Name field, such as Verification_Project.

(Optional) Use the “Browse...” option to change the project location in the Location field, if needed.
Click Next. The Propel Project Configure wizard is shown as Figure 2.63.

LU B R T ]
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%, Create System Design >
Propel Project Configure
Spedify a device or board for project.

Language:

SystemVerilog b

Select SoC Project:

M d/HelloWorld HelloWorld.sbx | | Browse...

Device and Template Info:

< Back Mext = Cancel

Figure 2.63. Create System Design — Propel Project Configure Wizard

6. (Optional) The default Hardware Description Language (HDL) is displayed in the Language area. Use the drop-down
menu to change the default language.

Select an existing SBX design by using Browse... to choose an SBX file, such as HelloWorld.
Click Next. The Project Information wizard opens.

Click Finish. A dut_inst of SoC project can be seen in the Schematic view (Figure 2.64).
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4. Propel Builder [C:/lscc/propel/2.0/workspace/Verification_Project/Verification_Project.sbx] Device: LIFCL-40-9BG400C - O X
File Edit View Design Window Help
~— L= ) =5 : " T
CE R 9 TmEXROEE @QQQaQ
Design View O Schematic Address Start Page
- ﬂ Verification_Project -
A 1? Instances
A ﬂ dut_inst
¥ {F Instances dut inst
» == Ports T T e e e --\
3 rE Mets | |
Components | |
' |
' |
—rstn_i led © [
|
- | I
Properties | I
—
Nome: —/ rxd i t.‘;(d_cal
Type: Instance \-._ ____________ /
Path: Verification_Project
VLMV: lattice:systembuilder:Verification Project: 1.0 v
4 3
IF Catalog Design View A v >
Tel Console m]
% sbp _design new -name Verification Project -path {C:/lscc/propel/2.0/workspace/Verification Project/
Verification Project.sbx} -device {LIFCL-40-595BG200C}
% sbp_add_ sbxcomp -name dut -path {C:/lscc/workspace/HelloWorld/HelloWorld/HelloWorld.sbx}
%

Figure 2.64. Verification Project

Note: The default instance name of an imported Design Under Test (DUT) is dut_inst. By default, its boundary is shown
with dotted line, and the filled-in color is gray. If there is any change in the SOC design, the dut_inst DUT block can be

updated accordingly by double-clicking this dut_inst DUT block, or by right-clicking this dut_inst DUT block and
choosing Reconfig.

ryi
I+I‘
10. Click the plus sign L= of this dut_inst DUT block. You can see the whole SoC Design (Figure 2.65). Click the
r=1

negative sign L1 to close the expanded bus.

dut_inst

gpio0_new
. 8 14850
0_inst ahbl0_inst LAPBS INTRE— i
FIRQ_S®HEL_MO_INSTREE] £RAHEL_S00 = L el
FHRQ _MO_INSTREE FAHBL : AHBL MOOLE gpio_o[7:0)
FIRQ_SIAHBL_M1_DATA! hbl_hclk_i i =
ok, i AHBL_MOLEEH
= fk_i TIMER_IRQ_MOF3= ahbl_bresetn i G5
rstn_§
tni system_resetn
J L
l uart0_inst
tHape_so
k_i INT_MOF
I A od oo
-y 2
—

Figure 2.65. Whole SoC Design

© 2021 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice.

FPGA-UG-02126-1.0 59


http://www.latticesemi.com/legal

Lattice Propel 2.0 Builder .'..LATTICE

User Guide

2.3.2. Switching SoC Project to Verification Project
Propel Builder supports switching SoC project to verification project manually after creating an SoC project

1. Create an SoC Project, such as HelloWorld project. Refer to the Creating Template SoC Project section for more
details.

Note: Corresponding Verification project is created automatically when creating a new empty SOC project. Hello World
Templates can have pre-developed Verification projects.

2. Click Switch Verification and Soc Design icon
opens (Figure 2.66), if a project is not saved.

from Propel Builder GUI Toolbar. Propel Builder dialog box

. Propel Builder >

o Save changes made to HelloWorld before opening ancther system design?

Yes Mo Cancel

Figure 2.66. Propel Builder Dialog Box

3. Click Yes in the Propel Builder dialog box. The Propel Builder GUI switches to verify the project (Figure 2.67).

*,, Propel Builder [C:/Iscc/workspace/HelloWorld/verification/HelloWorld_v.sbx] Device: LIFCL-40-3BG400C - a x

File Edit View Design Window Help

s & rmENo@EB QQQQ
Design View = Schematic Address Start Page
= 1F HelloWorld_v H
3 1? Instances
b Nets sysclk_rst_genl_inst uart_modell_inst

~ [ Components
| syscllc_rst_gen1:1.0.0
7| vart_modei1:1.0.0

dut_rst_o— uart_rx_data_debug =
dut_rsti th_ck o uart_tx_data_debug =

dut_ck_i dut_ck_o k uart_rx_break_debugi—
dut_inst
th_rst_o stn uart_rx_vald_debugf— e - )
[
——uart_rxd  uart_tx_busy_debugi— I :
! I ted_o
- ! uart_tx_en_debug— irstn_j ]
Properties | [ led_o—
! rt_txd e =]
Name: | uart_ :rx a 1
| f
Type: Instance | R ittt 7
Path:  HelloWorld_y |
VLNY: lattice:systembuider HelloWorld v:1.0 -
4 »
Design View 1P Catalog il oh
Tel Console ]
% sbp_replace -vlnv {latticesemi.com:ip:sysmem0:1.0.2} -name (sysmem0_inst} —component {HelloWorld/sysmem0_inst} -
% sbp_desion close
INFG - Finished: sbp design close
Finished: "sbp_design close”
% sbp_desion open -name HelloWorld v -path {C:/lscc/workspace/HelloWorld/verification/HelloWorld v.shx}
s =

Figure 2.67. Switching to Project Verification

Note: If the SoC project needs to be re-configured, click Switch Verification and Soc Design
verification project to the SoC project.

again to switch the

2.3.3. Opening a Verification Project

Refer to the Opening an SoC Existing Project section for procedure in detail.

2.3.4. Adding Modules, IPs and VIPs

Refer to the Adding Modules section for procedure in detail.
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2.3.5. Working with the Schematic View

Refer to the previous Working with the Schematic View section for procedure in detail.

2.3.6. Connecting Modules
Refer to the previous Connecting Modules section for procedure in detail.

2.3.7. Monitoring DUT

This feature is available to an SOC Verification project only. In Propel Builder, the pin inside DUT can be connected to
the input pin of a VIP. The connected pins can be found at both ends of the orange line, as shown in Figure 2.68. Only
pin, pin bus are supported in the current release of Propel Builder.

sysch_rst_gen_inst
ot axrad-
ez B o
SR PPV
o
g

=

5
e—
rec s

1 inst
il ahblD_inst ahbi2apbi)_inst -
Ao ] et
150 50 A IR tpmean 4 s s ”
i e oara ey . e N -
e a1 e s vy o on s
e
|— 3 s e ) =
1
oscl_inst
1'b1| oo
-beau nm,ﬂ-.. —

Figure 2.68. Monitoring DUT

The testbench generated for this Verification project is shown in Figure 2.69. This testbench file can be used for
simulation.

rscl ]-:_r;t_g;nI_i nst dut clk i net;

clk_rst genl inst dut clk i net = dut_inst.oscO_inst.hf clk out_o;

Figure 2.69. Testbench of the Verification Project
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2.3.8. Generating Simulation Environment

1.  Click the Generate icon 3 from the Propel Builder Toolbar to generate a testbench file including the scripts for
the chosen simulator, file list for HDLs, and some other files. The testbench file structure is shown in Figure 2.70.

[sim] -- generated simulation environment
[hdl_header]
soc_regs.v -- register definitions of all the components in DUT/SOC
sys_platform.v - base address, user settings of all the components in DUT/SOC
[misc]
* ¥ -- all the mem, hex, txt files will be copied here
flist.f -- file list for HDLs
msim.do -- do script for simulator, it can be gsim for Questasim
wave.do -- do script for adding signals in waveform window
<project_name>.sv -- top testbench, SystemVerilog based

Figure 2.70. Testbench File Structure

Unlike those HDLs generated in the SOC design, the testbench generation in the Verification project is just a start
point for you to work with. Make sure that you generate a new testbench, if there is an existing simulation
environment. A dialog box pops up prompting you to make a choice of Yes or No (Figure 2.71).

. Propel Builder x

o This cperation will overwrite the most recent result. Do you want to continue?

Yes Mo

Figure 2.71. Propel Builder — A Reminding Dialog Box

2.3.9. Launching Simulation

1. Click Launch Simulation icon from the Propel Builder Toolbar to launch simulation.

2. The default simulation tool, ModelSim, OEM version, opens (Figure 2.72).
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T Modelsim DE 20203 - o x
File Edt View Compile Simulate Add Wave Tools Layout Bookmarks Window Help
PRI Y ] ;hﬂﬁ?:=a-ﬂ‘“‘j|m n|\a°<~.,i|‘“a- W e e R B[ TS 2 ]| et rimisce -

A2-a-22-3] T wlg \gJu_Jﬂv|£é.7:ﬂL1 HE I Yy

QO RA% | p/mimi

e ———F . F T
¥|Name [type  [path
gl work Lbrary  C:/Users/syibinD
sl floatfudb Lbrary  $MODEL _TECH/.
Ml iese_env (emoty) Lbrary  $MODEL_TECH/.
w4l infoct Lbrary  $MODEL_TECH.
M moc_ams (emoty) Lbrary  $MODEL_TECH/.
mtiRnm (empty) Lbrary  $MODEL_TECH/.
2 osvvm Lbrary  $MODEL_TECH/.
sl ovi bfd Lbrary  $MODEL TECH/..
-, pi_wark 1 Lbrary  $MODEL TECH/..
s sv_std Lbrary  $MODEL_TECH/..
sl vh_odlv b Lbrary  $MODEL_TECH/..
sl vhdopt b Lirary _TECH/..
sl vital2000 Library L _TECH/.
il ieee Lbrary  $MODEL_TECH.
. modeism_ib Lirary $MODEL_TECH/.
s-fil std Lbrary  $MODEL_TECH/.
-l std_developersiit Lbrary  $MODEL_TECH/.
o symopsys Libvary  $MODEL TECH/. |
i, veriog Libvary  $MODEL_TECH/..
name Type (fitered) _|State :
K
57
+ 5
il | ~ j -
Moy [ emory st e ] L | | || e ] B2 semchFor = 1 () P am
R Transcript HE o x

Figure 2.72. Simulation GUI

Note: Before launching simulation, you can change Simulator to Questasim by clicking Design > Options from the
Builder Menu bar. Builder Options Wizard opens (Figure 2.73). Click Directories to set a desired Questasim

Location.
% Options ? x
Themes: Light -
General Color Metwark Settings Directories
IP TOOL
IP Install Path: Move IPs to new location

C:/Usersyzhao3 PropellPLocal e

Radiant Location

Diamond Location

Questasim Location

Set Default

Ok Cancel Apply

Figure 2.73. Builder Options Wizard
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IP Packager is a tool for you to create an IP package easily. You can edit port, file, parameter, and memory in the IP
Packager, and pack a customized IP directly.

IP Package is a collection of all required files related to an IP. All the related files are organized in different directories

(Figure 3.1).

- [IP Package]
- metadata.xml

[rtl]

[testbench]

[1dc]

- constraint.ldc
[driver]

- [ip_eval]
[plugin]

- plugin.py
[doc]

- introduction.html
- EULA.tXxt

Figure 3.1. Example Directories and Files of an IP Package

e metadata.xml [mandatory]: XML metadata file which mainly describes legal usage and interface of an IP.

e rtl [mandatory]: Directory for parameterized HDL source files. HDL source files contain configurable parameters for

you to configure.

e testbench [optional]: Directory for test bench files.

e |dc [optional]: Directory template constraint file. The file name should be “constraint.ldc”.

e driver [optional]: Directory for driver source code files.

e  plugin [optional]: Directory for Python script to implement internal logic of the soft IP. The file name of Python

script should be “plugin.py”.

e doc[mandatory]: Directory for documentation files. It should contain one mandatory introduction file, one
mandatory license agreement file, and other optional document.

The custom IP package can be used in Propel Builder for SoC design. IP instance package (Figure 3.2) is generated when

user configures IP in Propel Builder.

- <instance name>

<instance name>.cfg
<instance name>.ipx
component.xml
design.xml

[rtl]

- <instance name>.v

- <instance name> bb.v
[constraints]

- <instance name>.ldc
[driver]

[ip _eval]

[misc]

- <instance name> tmpl.v
- <instance name> tmpl.vhd

Figure 3.2. Example Directories and Files of an IP Instance Package
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3.1. Launching IP Packager
1. Choose Tools > ¢ IP Packager from the Lattice Propel Builder Menu Bar.
2. IP Packager is launched (Figure 3.3)
— [m] X

a IP Packager
File Edit Help

(= CE Nl

Figure 3.3. IP Packager GUI

3.2. Packing Custom IP Flow

3.2.1. Opening an IP Directory

1. Choose File > Open IP Directory from the Propel Builder Menu, or Click the Open Design icon from

Propel Builder Toolbar. The Select Folder dialog opens (Figure 3.4).
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™) Select Folder *
« v > This PC » DATA1(D:) » workspace » IP » v | D 2 Search IP
Organize + New folder B o
J‘S Music ~ MName Date modified Type Size
=] Pictures gpio 3/25/2021 9:25 AM File folder
B videos latticesemi.com_ip_gpio_1.4.1 3/25/2021 %:19 AM File folder
2 Windows (C) Mew folder 3/25/2021 9:25 AM File folder
- DATAT (D)
= Metwork ~
Folder: | latticesemi.com_ip_gpic_1.4.1
Select Folder Cancel

Figure 3.4. Select Folder Dialog

Choose a desired IP directory.

Click Select Folder. The IP Packager GUI shows the IP Package project (Figure 3.5). IP package project includes three
mandatory parts (Meta Data, Design File, and Doc) and two optional parts (Test Bench and Misc) that need to be
edited. Refer to the Editing IP section for more details.

66
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™ p Packager - D:/workspace/|P/latticesemi.com_ip_gpio_1.4.1 - O X
File Edit Help
+
L4 iy |
Project Meta Data
Basic Info
Design Files Parameters vendor: latticesemi.com
Test Bench * Ports Library: )
Misc B IN ibrary: ip
Doc Assistant 7 ouT Name: apio
O INOUT oi P10
Interfaces Epvine
Memory Map IP version: 1.0
Category: Processars_Controllers_and_Periphrerals
Supported platform: Radiant Fropel
Minimal Radiant version: 3.0
Minimal Propel version: 2.0
Default conn_mod: lscc_gpio
Supported Device Family
LFD2MX
LIFCL
LFMMX
Machx02
MachX03D
MachXO3L
MachXO3LF
Application Output | & %
set ip directory: D:/workspace/IP/latticesemi.com ip gpio 1.4.1 =
load existing ipk project from D:/workspace/IP/latticesemi.com ip gpio_l1.4.1
-
Output

Figure 3.5. IP Packager with IP Project Details

Note: If you prepared all directories and files of an IP module in advance, the IP Packager can load the information. If
you do not want to update the IP module information, you can skip the Editing IP section below.
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3.2.2. Editing IP

1. From the IP Packager Project area, click Mata Data. The IP Packager GUI shows Meta Data information in detail
(Figure 3.6).

™1 IP Packager - D:/workspace/IP/latticesemi.com_ip_gpio_1.4.1 — O >
File Edit Help
= 4
(=N |._ _..-|
Project Meta Data
Basic Info
Design Files Parameters Vendor: latticesemi.com
Test Bench * Ports Ly )
. ibrary: i
Misc = IN Y "
Doc Assistant = ouT MName: apio
O INOUT i -
Interfaces isplay name:
Memory Map IP version: 1.0
Category: Processors_Controllers_and_Periphrerals
Supported platform: Radiant Propel
Minimal Radiant version: 3.0
Minimal Propel version: 2.0
Default conn_mod: lsce_gpio
Supported Device Family
B LFD2NX
B LFCL
B LFMNK
Machx02
E Machx03D
B MachX03L
B MachX03LF
Application Output | &1 X
set ip directory: D:/workspace/IP/latticesemi.com ip gpio 1.4.1 =
load existing ipk project from D:/workspace/IP/latticesemi.com ip gpio 1.4.1
-
Qutput

Figure 3.6. IP Packager with Meta Data Details

a. To configure basic information:
+ Click Basic Info from Meta Data view (Figure 3.7).
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¢« You can see the Basic Info properties in detail as shown in Figure 3.8.

Meta Data

:Basic Info

* Parameters

» B3

* Ports
PN
PO OUT
P INOUT

¥ Interfaces

APB_S0
IMNTR
* Memory Map

b gpio_mem_map

Figure 3.7. Meta Data View

Meta Data
iBasic Info
Parameters Vendor: latticesemi.com
> Ports lib )
ibrary: ip
[ IN
<1 ouTt Mame: gpio
< INOUT oi .
Interfaces isplay name:
Memory Map IP version: 1.0
Category: Processors_Controllers_and_Periphrerals
Supported platform: Radiant Propel
Minimal Radiant version: 3.0
Minimal Propel version: 2.0
Default conn_maod: lscc_gpio

Supported Device Family
[ LFD2MX

[ UFcL

[ LFmMNX

E Machxo2

[ Machx03D

[ Machx03L

[ Machx03LF

Figure 3.8. Configure Basic Info
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¢ Configure the basic information by entering desired value for a property or checking the checkbox for the
property in the property field. For example, click the Vendor filed to enter a desired vendor value.

Note: IP Packager supports both Radiant and Propel software. IP Packager is based on Radiant 3.0, but
does not support Radiant version of which is lower than 3.0. “Minimal Radiant version” should be set to
3.0 or 3.0+. For Propel, IP Packager is based on Propel 2.0, not support Propel version of which is lower
than 2.0. “Minimal Propel version” should be set to 2.0 or 2.0+. If the version of Radiant or Propel is
invalid, the warning message is shown (Figure 3.9).

Meta Data
Basic Info
Parameters Vendor: latticesemi.com
v Ports Library: ip
N
- ouT Mame: gpio
O INOUT
Interfaces Display name: GPIO
Memory Map IP version: 1.0
Category: Processors_Controllers_and_Periphrerals
Supported platform: Radiant Fropel

Minimal Radiant version: = 2.3

Minimal Propel version: 1.1

Default conn_mod: lscc_gpio

Supported Device Family

LFD2MX
LIFCL
LFMMX
Machx02
MachXQ3D

MachX03L .

Figure 3.9. Warning Message of the Invalid Radiant and Propel Version

b. To configure parameters:
« Right-click Parameters from Meta Data view, and choose Add Parameter Tab (Figure 3.10). Parameters
create Tab1l items.
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Meta Data

Basic Info

Add Parameter Tab

—r NG
Interfaces
Mernory M:

Figure 3.10. Right-click Menu of Parameters in the Meta Data View

¢ Right-click Tabl under Parameters from Meta Data view, and choose Add Parameter Group. Group1 is
newly added under Tab1 (Figure 3.11). Groupl is used to group the settings. Settings of the same
“groupl” are displayed as sub-items under a group item on GUI. The settings with the same “group1”
should be written continuously if you want GUI to group them under one group item, otherwise you can
see multiple groups with the same name in GUI. Tab1 is used to Group the “groupl1” groups. “groupl”
groups of the same “Tab1” are displayed in a separate page on GUI. So, two level hierarchy is supported
in GUI display. Unlike ‘groupl’, you need not write setting nodes with the same ‘Tab1’ continuously but
you must follow the rule for ‘groupl’ that all the settings with the same ‘group1’ must be in the same
‘Tabl’.

Basic Info
* Parameters
- Tab1

Group1
* Ports
I
ouT
o INOUT
Interfaces

Mernory Map

Figure 3.11. Groupl Added to Tab1l

¢ Right-click Group1 under Tab1l from the Meta Data view, and choose Add Parameter. NewParam1 is
newly added under Group1 (Figure 3.12).
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Meta Data
Basic Info
¥ Parameters Property Value
T L Tkl title
- Groupl
type param
~* Pors
N value_type
- out conn_mod lscc_gpio
< INOUT
Interfaces default
M M
smory Map value_expr
options

output_formatter
bool_value_mapping
editable

hidden

drc

regex

value_range
config_groups

description

Figure 3.12. NewParam1 Added to Group1l

« Double-click NewParam1 to rename the parameter (Figure 3.13). The parameter name is also used as the
unique ID of the parameter setting.

Basic Info

* Parameters

-

* Ports
c
2 out

Tab1
Groupl
FAMIL

O INOUT

Interfaces

Mernory Map

Figure 3.13. Rename a Parameter

« Double-click the property value field to enter the desired parameter value, or select the desired value
from drop-down menu (Figure 3.14). The properties are thus configured. Property listed in bold must be

configured. The details of each property is shown in Table 3.1
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~ Parameters

-

¥ Ports

Tab1

Group1
FAMILY

IN
out

= INOUT

Interfaces
Memary Map

Property Value
title Device Architecture
type param
value_type string
conn_mod lscc_gpio
default LIFCL
value_expr
options
output_formatter
bool_value_mapping
editable False
hidden True 7
dre Faie
regex
value_range

config_groups

description

Figure 3.14. Configure a Parameter

Table 3.1. Details of Parameter Property

Property Value Mandatory Description

title String No Short title of the setting. If “title” is not specified, value of “id” is used.
Example:
title="Device Architecture”

type param, input, Yes A setting can be a Verilog parameter, Verilog macro definition or user input.

command Param, verilog_macro and input settings can be used to compute values of

other param and input settings. They only differ in generated files. param is
written out as a Verilog parameter value pf the IP module, verilog_macro is
translated to a Verilog macro definition by the define compiler directives, but
input is not. Command shows as a button.
Example:
type="param”

value_type | bool, string, Yes Type of the value. Supported types are bool, int, float, string and path. The

int, float, path int type supports unlimited precision.

The float type supports the precision of float type of C programming language.
Refer to the Characteristics of Floating Types section of the 1999 ISO/IEC C
Standard for details.
The path type indicates a string which represents a path. “/” is used as
separator.
Example:
value_type="string”

conn_mod | String Yes Name of soft IP module to which this setting applies to.
Example:
conn_mod="Iscc_gpio”

www.latticesemi.com/legal



http://www.latticesemi.com/legal
http://www.open-std.org/jtc1/sc22/wg14/www/docs/n1256.pdf
http://www.open-std.org/jtc1/sc22/wg14/www/docs/n1256.pdf

mLATTICE

Property Value Mandatory Description
default Python No Default value of the setting. If the setting has no “default” attribute but has
expression "options" attribute, the first option is picked as default value. If the setting has
neither “default” attribute nor “options” attribute, the initial value of setting is
set to O for int, 0.0 for float, “” for string and False for bool. By default, it is not
allowed to reference to other setting values. Use value_expr as reference
values.
Example:
default="LIFCL”
value_expr | Python No Python expression to compute the value of the setting. The result is used as the
expression parameter value if the setting is not editable. For example, divider is calculated
by frequencies.
Example:
value_expr="int(round((sys_clock_freq * 250.0) / i2c_left_desired_frequency))-
1
options Python list or No Candidate options for the setting, which is used by GUI to display a dropdown
list of tuples selector. It can be set to a simple list or a list of tuples. If it is a simple list,
elements are displayed and written. Ifitis a list of tuples, the first item in tuple
is displayed and the second item in tuple is written.
Example:
options="[0.1, 0.2, 0.5, 1.0]”
output_for | str No Control how parameter values are written in output RTL files. Following
matter formatters are supported.
str: parameter values are written as strings
nostr: quotation marks of strings are removed
Example:
output_formatter="str”
bool_value | Python tuple No The map-to-map bool values to dedicated strings. By default, bool values are
_mapping or list with 2 written as 1, 0.
string elements Example:
bool_value_mapping="(‘True’, ‘False’)”
editable Python No Python expression to determine if the setting is editable. When a setting is not
expression editable, it is grayed out in GUI display and its value is computed by value_expr.
Otherwise, user input is used.
Example:
editable="(FEEDBACK_PATH == 'PHASE_AND_DELAY')
(FEEDBACK_PATH is a setting ID in metadata.xml)
hidden True No Python expression to determine whether or not the setting is hidden in GUI. If
hidden is set to True (default is False), the item is hidden in GUI. The expression
is resolved to boolean value after the user setting is changed.
Example:
hidden="True”
drc Python No Python expression to do DRC on the setting. True means DRC pass.
expression Example:
drc="check_valid_addr_pre(12C_LEFT_ADDRESSING_PRE,i2c_left_addressing_wi
dth)"
(check_valid_addr_pre is defined in plugin.py
setting ID: I2C_LEFT_ADDRESSING_PRE
i2c_left_addressing_width
)
regex Regular No Regular expression to do DRC on the value. For example, the value should be
expression prefixed by “Ob”.
Example:
regex="0b[01]+”
value_rang | Python tuple No Valid range of setting value, which is used to do DRC on the setting. The
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e or list with 2 maximum value can be infinity “float(‘inf’)”.
comparable Example:
elements value_range="(0, 1023) if(i2c_right_enable) else (-9999, 9999)"
config_gro Python No A name or names to group settings together. It is copied from IP-XACT
ups expression configGroups attribute, and only supports “SystemBuilder” value. If it is
defined, related RTL parameter is brought out to IP instance top module, so that
System Builder can re-define its value.
description | String No Detailed description of the setting.
macro_na id, value No Specify how to name the Verilog macro in ‘verilog_macro’ type setting item, the
me ID or value of this setting item. The default value is ‘id’, which means the

setting’s ID will be defined as a Verilog macro. If it is set as ‘value’, the evaluated
setting value is the Verilog macro.

Example:

maro_name= "value"

Result: “define <setting value>

Note: This is only be considered in the setting item whose ‘value_type’ attribute
is set to ‘string’.

c. To configure Ports:

Repeat steps above to configure all parameters as desired.

Click Ports from the Meta Data Tree, three port types (IN, OUT, INOUT) (Figure 3.15) are listed.

* Ports

IM
ouT
= INOUT

Figure 3.15. Three Port Types

Right-click IN from the Ports area, and choose Add Port (Figure 3.16).
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Meta Data

Basic Info
* Parameters

— NG
Interfaces
Mernory M: Add Port

Infer Ports from HDL

Figure 3.16. Right-click Menu of the IN Port

Note: You can add all ports by using Infer Ports from HDL, if you prepare valid RTL files and add RTL files in Design
Files section. Click Infer Ports from HDL, the Add inferred ports to meta data wizard pops up (Figure 3.17). If you
have added some ports and then choose Infer Ports from HDL, all the previously-added ports are removed and

only ports from the HDL file can be added.
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) Add inferred ports to meta data

Inferred Ports Direction Range
clk_ in
B resetn i in
f |Immi_wdata_i in (31,0
B Immi_rdata_o out 31,00
Irmmi_rdata_valid_o out
B Immi_ready_o out
Irmmi_wr_rdn_i in
B Immi_offset_i in 3,0
Immi_request_i in
E into out
apb_penable_i in
| aphb_psel_i in
aphb_pwrite_i in
[ apb_paddr_i in (5,00
apb_pwdata_i in (31,0
Ok Cancel

Figure 3.17. Add inferred ports to meta data Wizard
NewPortl is created. Double click NewPort1 to rename the port (Figure 3.18).

* Ports
* [N
Zoout
O INOUT

Figure 3.18. Rename an IN Port

Configure all properties of the IN port as desired (Figure 3.19). Property listed in bold must be configured.
The details of each property is shown in Table 3.2.
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igpio_i

clk_i

resetn_i
Immi_request_i
Imimi_wr_rdn_i
Immi_offset_i
Immi_wdata_i
apb_penable_i
aph_psel_i
aph_pwrite_i
apb_paddr_i
apb_pwdata_i
ouT

= INOUT

b Interfaces
b Memory Map

Property
range
conn_mod
conn_port
conn_range
stick_high
stick_low
stick_value
dangling
attribute

port_type

mLATTICE

Value
(1O_LINES_COUMNT - 1, 0)
Iscc_gpio

gpio_i

EXTERMNAL_BUF == False

Figure 3.19. Configure an IN Port

Table 3.2. Details of Port Property

Property Value Mandatory Description
range Python tuple or list No Range of this port. It should be a Python expression whose
with two-integer evaluation result is a tuple or array with two elements.
elements Example:
range="(A_WDT-1, 0)"
(A_WDT is a setting ID)
conn_mod Valid Verilog Yes Name of the IP core module to which this port connects.
module name Example:
conn_mod="counter”
conn_port Valid Verilog No Name of port of IP core module to which this port connects.
module name Value of “name” is used if “conn_port” is not specified.
Example:
conn_port="CIk"
conn_range Python tuple or list No Range of conn_port. It should be a Python expression whose
with two-integer evaluation result is a tuple or array with two elements.
elements Example:
conn_range="(A_WDT-1, 0)"
(A_WDT is a setting ID)
stick_high Python expression No Python script. True: tie this port to 1.
Example:
stick_high="True”
stick_low Python expression No Python script. True: tie this port to 0.
Example:
stick_low="no_seq_pins()"
(no_seq_pins is defined in plugin.py)
stick_value Python expression No Python script. Tie port to the evaluation result of this attribute.
dangling Python expression No Python script. True: keep this port unconnected.
Example:
dangling="not USE_COUT"
(USE_COUT is a setting ID)
attribute Python expression No Python script. The value can be written to the .v file as the
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Property Value Mandatory Description
attribute of the port.
Example:
attribute=""(* AAA, BBB=1 *)"”
=>(* AAA, BBB=1*) input PORT;
port_type String No ‘data’, ‘reset’ and ‘clock’ are valid values. The default value is

‘data’.

port_type can be passed to the IPXact component.xml as an
Isccip:isClk or Issccip:isRst node in venderExtensions in
component/model/ports/port.

« Repeat steps above to configure all ports as desired.

d. To configure Interfaces:
+ Right-click Interfaces from the Meta Data view, and choose Add Interface (Figure 3.20). A new interface

Newlnterfacel is created.

iInterfaces

Add Interface

Figure 3.20. Right-click Menu of an Interface

+« Double click NewlInterfacel to rename interface (Figure 3.21).

« Configure the interface as desired (Figure 3.22).

-

Interfaces

9 5)

Figure 3.21. Rename Interface
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™*1 IP Packager - D:/werkspace/IP/latticesemi.com_ip_gpio_1.4.1 - O X
File Edit Help
= b
L] iy |
Project Meta Data
Meta Data Basic Info
Design Files ~ Parameters Display Name: APE_SD
Test Bench [ -
Misc ~ Ports Description: APE slave port
Doc Assistant yo N Interface Type: amba.com:AMBA3:APB:r 1p0 -
» O ouT - =
» @ INOUT o o
~ Interfaces Mem Map Reference: | gpio_mem_map -
(APB SO -
INTR ort Map:
* Memory Map Logical Port Physical Port
PADDR apb_paddr_i
PCLK
PCLKEMN
PENABLE apb_penable_i
PRDATA apb_prdata_o
PREADY apb_pready_o
PRESETh
PSELx aph_psel_i
PSLVERR aph_pslverr_o
PWDATA apb_pwdata_i
PWRITE apb_pwrite_i
Application Output 53 X
set ip directory: D:/workspace/IP/latticesemi.com ip gpio_1.4.1 -
load existing ipk project from D:/workspace/IP/latticesemi.com ip gpioc 1.4.1
Output

Figure 3.22. Configure an Interface

¢« Repeat steps above to configure all interfaces as desired.
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e. To configure Memory Map:
¢ Right-click Memory Map from the Meta Data Tree, and choose Import Memory Map from CSV
(Figure 3.23). New memory map is created (Figure 3.24).
Note: Propel 2.0 Builder only supports using Import Memory Map from CSV to create memory map.
There are some issues if you use Add Memory Map.

Add Memory Map
Irmport Memory Map from C5V

Figure 3.23. Right-click Menu of a Memory Map
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P Packager - D:/workspace/IP/latticesemi.com_ip_gpio_1.4.1 — O *
File Edit Help
— = ke
4] ]
Project Meta Data
Meta Data Basic Info
Design Files ~ Parameters Property Value
Test Bench [ descrioti -
Misc - Ports escription memory map
Doc Assistant »IN
vy O ouT
b D INOUT
~ Interfaces
APB_SD
INTR
* Memory Map
P,
Application Cutput 5_-| X
set ip directory: D:/workspace/IP/latticesemi.com ip gpioc 1.4.1 =
load existing ipk project from D:/workspace/IP/latticesemi.com ip gpio_1.4.1
-
Output

Figure 3.24. Generate New Memory Map
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2. From the IP Packager Project area, click Design Files. IP Packager GUI shows the Design Files information
(Figure 3.25).

*p Packager - D:/workspace/IP/latticesemi.com_ip_gpic_1.4.1 — O X
File Edit Help
= IEI 9
Praoject Design Filas
Meta Data
Design Files RTL Files: Add Remaove
Test Bench . .
Misc MName Lib Encryption
Doc Assistant D:/workspace/IP/latticesemi.com_ip_gpio_1.4.1/rtl/lscc_apb2lmmi.v

D:/workspace/IP/latticesemni.com_ip_gpio_1.4.1/rtl/lscc_gpio_lmmiwv

D:/workspace/IP/latticesemi.com_ip_gpio_1.4.1/rtl/lscc_gpio.w

Constraint File:

Application Output | &1 X

set ip directory: D:/workspace/IP/latticesemi.com ip gpioc_1.4.1 =

load existing ipk project from D:/workspace/IP/latticesemi.com ip gpic_l1.4.1

Output

Figure 3.25. IP Packager with Design File Details

e Click the Add button to select a desired rtl file in the Design Files field. Click the Remove button

to remove an RTL file. Use the “...” option to add a desired constraint file.
Note: Design file configuration is mandatory. Specify at least one RTL file. If the RTL file needs to be

encrypted, check the Encryption option for it.
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3.

From the IP Packager Project area, click Test Bench. The Test Bench information is shown in detail (Figure 3.26).

- O X

P Packager - D/workspace/IP/latticesemi.com_ip_gpio_1.4.1

File Edit Help

& £
Project

Meta Data
Design Files

Test Bench

Misc

Doc Assistant

Test Bench
Add Remove

Testbench Files:
D:/waorkspace/IP/latticesemi.com_ip_gpie_1.4.1/testbench/lscc_mmi2apb.v

D:fworkspace/IP/|atticesemi.com_ip_gpio_1.4.1/testbench/tb_top.w

Application Output | &9 X
set ip directory: D:/workspace/IP/latticesemi.com ip gpic 1.4.1 =
load existing ipk project from D:/workspace/IFP/latticesemi.com ip gpio_1.4.1

-

Output

Figure 3.26. IP Packager with Test Bench Details

Follow the steps as those for configuring the Design Files to configure the Test Bench. The Test Bench files

configuration is not mandatory.
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From the IP Packager Project area, click Misc. The Misc related information is shown in detail (Figure 3.27).

4,
Configure Misc information as desired.
*1 IP Packager - D:/workspace/IP/latticesemi.com_ip_gpio_1.4.1 — O *
File Edit Help
— = +
4]
Project Misc
Meta Data
Design Files Document: Add Remove
Test Bench
Misc D:/workspace/|P/latticesemi.com_ip_gpio_1.4.1/doc/intreduction.html
Doc Assistant
Driver Files: Add Remove
D:/waorkspace/|P/latticesemi.com_ip_gpio_1.4.1/driver/gpio.c B
D:/workspace/IP/latticesemi.com_ip_gpio_1.4.1/driver/gpic.h
D:fworkspace/|P/latticesemi.com_ip_gpio_1.4.1/driver/gpic_regs.h .
Add Remove

IP Evaluation Files:

D: fworkspace /TP latticesemi. com_ip_gpio_1.4. 1/plugin/plugin. py

Plugin File:
EULA File: | D:fworkspace,TF flatticesemi.com_ip_gpio_1.4. 1/doc/EULA. txt
Application Output | &1 *
set ip directory: D:/workspace/IP/latticesemi.com ip gpioc 1.4.1 =
load existing ipk project from D:/workspace/IP/latticesemi.com ip_gpic_1.4.1

-

Output

Figure 3.27. IP Packager with Misc Details
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5. From the IP Packager Project area, click Doc Assistant. The Doc Assistant information is shown in detail

(Figure 3.28).

P Packager - D:/workspace/IP/latticesemi.com_ip_gpio_1.4.1

File Edit Help

= +
= IP
Project Doc Assistant
Met.a DaFa This helps you quickly create an introduction html page for IP.
Design Files
Title:

Test Bench
Mi

1 Description:

Device support:

Revision history:
Revision Content

Add Remove Save and Add to IP Package

Application Output é_'l
set ip directory: D:/workspace/IP/latticesemi.com ip gpic 1.4.1
load existing ipk project fzrom D:/workspace/IP/latticesemi.com ip gpioc_l.4.1

Output

Figure 3.28. IP Packager with Doc Assistant Details

Enter the desired title, description, and device in the Title, Description, and Device support fields

accordingly.
Double-click and enter a revision in Revision field. Double-click and enter revision contents in Content

field. Refer to Figure 3.29 as an example. Click the Add button. A new blank row is added to the
Revision History area. You can add desired revision and contents accordingly. Select the revision you want

to delete, and click the Remove button to remove a Revision.

e Click the Save and Add to IP Package button to create an introduction html page and save this file to the IP

package.
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File Edit

Project

Meta Data
Design Files
Test Bench
Misc

Doc Assistant

P Packager - Dt/workspace/IP/latticesemi.com_ip_gpio_1.4.1

Help

Doc Assistant

This helps you quickly create an introduction html page for IP.
Title: GPIO

Description: General-Purpose Input/Output {GPIO) peripheral IP provides dedicated memaory-mapped

Device support: | iCE40UP 5K, iCE40UP3K, LIFCL-40, LIFCL-17, MachXO3D, LFMNX-50, LFD2MNX-40, LFCPNX-100, MachxO2

Revision history:

interface to configure GPIO ports as well as the number of input and output ports.

set ip directory: D:/workspace/IP/latticesemi.com ip gpio_l.%4.1
load existing ipk project from D:/wo:kspace/IP/laccicesemi.com_ip_gpio_l.e.l

Qutput

Revision Content
141 Added MachX02 device support
140 Added Jedi-D1 support
130 Added option to remove tri-state buffer and Mach-NX device support
1.2.0 Added MachX03D and Certus-MX device support
110 Added CrossLink-NX device support
1.00 Initial release
Add Remove Save and Add to IP Package
Application Qutput | &1 x

Figure 3.29. Configure Doc Assistant
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3.2.3. Previewing IP

1. Choose Edit >

Toolbar.

2. IP Preview pops up showing the configuration component for the IP module (Figure 3.30), if the IP project
configuration is correct. Otherwise, the IP Packager pops up an error message (Figure 3.31).

IP Preview from Propel Builder menu. Or, click the IP Preview icon from Propel Builder

[ IP Preview b4

Configure Component from Module gpio
Version latticesemi.com

Set the following parameters to configure this component.

Diagram test Configure IP
*| Property Value
~ General
Mumber of /O Lines [1-32] 1
Remove Tri-5tate Buffer
Initial Qutput Value (hex) [0 - FFFFFFFF] | O
test 10 Direction (hex) [0 - FFFFFFFF] 1
Interface APB
PB_SU INT
clk_i o
~ gpio_io[0:0]
resetn_i
gpio
4 4 N Mo DRC issues are found.
Cancel
Figure 3.30. IP Preview Shows Configuration for IP Module
-+
™1 IP Packager X

ERROR: No RTL file found.
Click the Add button te add mandatory IP input files --- meta data, RTL and
Document files.

OK

Figure 3.31. IP Packager Pops up Error Message
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3.2.4. Packaging IP
+ +

1. Choose Edit > Package IP from Propel Builder menu. Or, click the Package IP icon from Propel Builder
Toolbar.

2. IP Packager pops up a message showing the packaging is completed successfully (Figure 3.32).

IP Packager >

Package files to IP(D:
‘weorkspaceh|Phlatticesemi.com_ip_gpio_1.4. 1\ atticeseri.com_gpic_1.4.1.ipk)
successfully.

0.4

Figure 3.32. IP Packager Pops up Successful Packaging Message

3.3. Editing IP Package Files

3.3.1. Meta Data File

Metadata.xml can be generated after editing IP. You also can manually edit the file. IP Platform uses XML file to
describe metadata of a soft IP. Namespace “Isccip” is used in XML file. The content of the XML file consists of three
mandatory nodes including <general>, <settings> and <ports>, five optional nodes including <busInterfaces>,
<addressSpaces>, <memoryMaps>, <componentGenerators> and <estimatedResources>. One optional new child node
<outFileConfigs> is added to support the customized IP generation flow in Propel (Figure 3.33).

<lsccip:ip
xmlns:lsccip="http://www.latticesemi.com/XMLSchema/Radiant/ip"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
version="1.0">

<lsccip:general>

</lsccip:general>

<lsccip:settings>

</lsccip:settings>

<lsccip:ports>

</lsccip:ports>
</lsccip:ip>

Figure 3.33. Example XML of Metadata Layout

1. <general>node: describes general information about a soft IP, for example, name, version, and category. Table 3.3
shows the child nodes of <general> node.
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Child Node

Mandatory

Description

vendor

Yes

Soft IP vendor. Official soft IPs should have vendor name.
Example:
“latticesemi.com”

library

Yes

Library of the soft IP. If “library” is not set, the default value “ip” is used.
Example:

wonou

ip”, “interface”

name

Yes

Name of the soft IP. The name must be unique among soft IPs of the same
vendor and library.

Example:

"adder"

display_name

No

Name to be displayed in the software. If “display_name” is not set,
software displays “name” directly.

Example:

“Adder”

version

Yes

Version of the soft IP.
Example:
1.0.0

category

Yes

Category of the soft IP. Category can be hierarchical. Levels are separated
by “”".
Example:

keywords

No

Memory_Modules,Distributed_RAM

Keywords of the soft IP. Multiple keywords are separated by “,”.
Example:

BusType_AHB,BusType_APB

min_radiant_version

Yes

The minimal Radiant version, which supports the soft IP.
Example:
1.0 (no service pack), 1.0.1 (with service pack)

max_radiant_version

No

The maximal Radiant version, which supports the soft IP.
Example:
2.0.

supported_products

No

FPGA products supported by the soft IP.

type

No

Enhancement for cpu IP.

min_esi_version

No

The minimal ESI version, which supports the soft IP.
Enhancement for esi.

max_esi_version

No

The maximal ESI version, which supports the soft IP.
Enhancement for esi.

supported_platforms

No

Default is Radiant, specific for esi.
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2. <settings> node: describes parameters information that should contain one or more <setting> nodes. In an IP
instance package, Verilog parameters are used to configure the soft IP. All user configurable parameters should be
added to the <settings> section as <setting> nodes. Beside parameters, you can add <setting> nodes for user-input
only. Table 3.4 shows attributes of <setting> nodes.

Table 3.4. Attributes of Setting Nodes

Attribute Value Mandatory Description

id String Yes The unique ID of the setting, which is also be referred as:
Parameter name in RTL codes

Python variable name

Tcl variable name

To make value of the “id” valid in Verilog HDL, Python and Tcl, it should
consist of only letters, digits and underscore. The first character should be
letter.

Example:

id="num_outputs”

title String No Short title of the setting. If “title” is not specified, value of “id” is used.
Example:
title="Number of Output”

type param, input, | Yes A setting can be a Verilog parameter, Verilog macro definition or user input.
command Param, verilog_macro and input settings can be used to compute values of
other param and input settings. They only differ in generated files. param is
written out as a Verilog parameter value pf the IP module, verilog_macro is
translated to a Verilog macro definition by the define compiler directives,
but input is not. Command shows as a button.

Example:

type="param”

value_type bool, string, Yes Type of the value. Supported types are bool, int, float, string and path.
int, float, The int type supports unlimited precision.
path The float type supports the precision of float type of C programming
language.

Refer to the Characteristics of Floating Types section of the 1999 ISO/IEC C
Standard for details.

The path type indicates a string which represents a path. “/” is used as
separator.

Example:

value_type="int"

conn_mod String Yes Name of soft IP module to which this setting applies to.
Example:
conn_mod="pl

|u

default Python No Default value of the setting. If the setting has no “default” attribute but has
expression "options" attribute, the first option is picked as default value. If the setting
has neither “default” attribute nor “options” attribute, the initial value of
setting is set to O for int, 0.0 for float, “” for string and False for bool.
Example:

default="1.0"

value_expr Python No Python expression to compute the value of the setting. The result is used as
expression parameter value if the setting is not editable. For example, divider is
calculated by frequencies.

Example:

value_expr="int(round((sys_clock_freq * 250.0) /
i2c_left_desired_frequency))-1"

options Python listor | No Candidate options for the setting, which is used by GUI to display a
list of tuples dropdown selector. It can be set to a simple list or a list of tuples. Ifitisa
simple list, elements are displayed and written. If it is a list of tuples, the
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Attribute Value Mandatory Description
first item in tuple is displayed and the second item in tuple is written.
Example:
options="[0.1, 0.2, 0.5, 1.0]”
output_formatt | str No Control how parameter values are written in output RTL files. Following
er formatters are supported.
str: parameter values are written as strings
nostr: quotation marks of strings are removed
Example:
output_formatter="str”
bool_value_ma Python tuple No The map-to-map bool values to dedicated strings. By default, bool values
pping or list with 2 are written as 1, 0.
string Example:
elements bool_value_mapping="(‘True’, ‘False’)”
editable Python No Python expression to determine if the setting is editable. When a setting is
expression not editable, it is grayed out in GUI display and its value is computed by
value_expr. Otherwise, user input is used.
Example:
editable="(FEEDBACK_PATH == 'PHASE_AND_DELAY')
(FEEDBACK_PATH is a setting ID in metadata.xml)
hidden True No Python expression to determine whether the setting is hidden in GUI. If
hidden is set to True (default is False), the item is hidden in GUI. The
expression is resolved to boolean value after the user setting is changed.
Example:
hidden="True”
drc Python No Python expression to do DRC on the setting. True means DRC pass.
expression Example:
drc="check_valid_addr_pre(12C_LEFT_ADDRESSING_PRE,i2c_left_addressing
_width)"
(check_valid_addr_pre is defined in plugin.py
setting ID: I2C_LEFT_ADDRESSING_PRE
i2c_left_addressing_width
)
regex Regular No Regular expression to do DRC on the value. For example, the value should
expression be prefixed by “Ob”.
Example:
regex="0b[01]+”
value_range Python tuple No Valid range of setting value, which is used to do DRC on the setting. The
or list with 2 maximum value can be infinity “float(‘inf’)”.
comparable Example:
elements value_range="(0, 1023) if(i2c_right_enable) else (-9999, 9999)"
config_groups Python No A name or names to group settings together. It is copied from IP-XACT
expression configGroups attribute, and only supports “SystemBuilder” value. Ifitis
defined, related RTL parameter is brought out to IP instance top module, so
that System Builder can re-define its value.
description String No Detailed description of the setting.
groupl String No Group the settings. Settings of the same “groupl” is displayed as sub-items
under a group item on GUI. The settings with the same “group1” should be
written continuously if you want GUI to group them under one group item.
Otherwise, you can see multiple groups with the same name in GUI.
Example:
groupl="Output Setting"
group2 String No Group the “groupl” groups. “groupl” groups of the same “group2” is

displayed in a separate page on GUI. So, two-level hierarchy is supported in
GUI display.
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Attribute Value Mandatory Description
Unlike ‘groupl’, you need not write setting nodes with the same ‘group2’
continuously. You must follow the rule for ‘groupl’ that all the settings with
the same ‘groupl’ must be in the same ‘group2’.

macro_name id, value No Specify how to name the Verilog macro in ‘verilog_macro’ type setting item,

the ID or value of this setting item. The default value is ‘id’, which means the
setting ID is defined as a Verilog macro. If it is set as ‘value’, the evaluated
setting value is the Verilog macro.

Example:

maro_name= "value"

Result: ‘define <setting value>

Note: This is only be considered in the setting item whose ‘value_type’
attribute is set to ‘string’.

3. <ports> node: IP module package has some ports in its implementation. These ports should be described in
<ports> section as <port> child nodes. If an input port is stick to fixed value, or an output port is dangling, the port
is not used and is invisible after generation. Table 3.5 shows the attributes of <port> nodes.

Table 3.5. Attributes of Port Nodes

Attribute Value Mandatory Description
name Valid Verilog port Yes Name of a port.
name Example:
name="Clk”
dir in, out, inout Yes Direction of a port.
Example:
dir="in"
range Python tuple or list No Range of this port. It should be a Python expression whose
with 2 int elements evaluation result is a tuple or array with 2 elements.
Example:
range="(A_WDT-1, 0)"
(A_WDT is a setting ID)
conn_mod Valid Verilog Yes Name of an IP core module to which this port connects.
module name Example:
conn_mod="counter”
conn_port Valid Verilog No Name of port of an IP core module to which this port connects.
module name Value of “name” is used, if “conn_port” is not specified.
Example:
conn_port="CIk”
conn_range Python tuple or list No Range of conn_port. It should be a Python expression whose
with 2 int elements evaluation result is a tuple or array with 2 elements.
Example:
conn_range="(A_WDT-1, 0)"
(A_WDT is a setting ID)
stick_high Python expression No Python script. True: tie this port to 1.
Example:
stick_high="True”
stick_low Python expression No Python script. True: tie this port to 0.
Example:
stick_low="no_seq_pins()"
(no_seq_pins is defined in plugin.py)
stick_value Python expression No Python script. Tie port to the evaluation result of this attribute.
dangling Python expression No Python script. True: keep this port unconnected.
Example:
dangling="not USE_COUT"
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Attribute Value Mandatory Description
(USE_COUT is a setting ID)

bus_interface Valid bus interface No Bus interface name defined in <busInterfaces> node.

name Example:

bus_interface=" ahb_slave_0"

attribute Python expression No Python script. The value is written to the .v file as the attribute of
the port.
Example:
attribute=""(* AAA, BBB=1 *)"”
=> (* AAA, BBB=1*) input PORT;

port_type String No ‘data’, ‘reset’ and ‘clock’ are valid values. The default value is

‘data’

port_type will be passed to the IPXact component.xml as an
Isccip:isClk or Issccip:isRst node in venderExtensions in
component/model/ports/port

<buslinterfaces> node: contains a list of all interfaces ports of the soft IP (Figure 3.34). The description follows
IP-XACT format. Refer to IEEE 1685-2014: |IEEE Standard for IP-XACT, Standard Structure for Packaging, Integrating,
and Reusing IP within Tool Flows for more details. The businterface has a list of portMap, which defines logicalPort
name and physicalPort name. In <ports> nodes, one port can have optional “bus_interface” attribute, which binds
the port with a businterface. If one port is bound to the businterface, its name should match physicalPort name of
one portMap of the businterface, so that port and businterface/portMap is bound together. Whether or not a port
can be used is based on user configuration. If the port is used, the corresponding portMap in businterface is
written to the output IP-XACT file. Otherwise, the corresponding portMap in businterface is not written to the
output IP-XACT file.
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<lsccip:busInterfaces>
<lsccip:busInterface>

<lsccip:name>AHBL S00</lsccip:name>

<lsccip:displayName>AHBL S00</lsccip:displayName>

<lsccip:description>AHB-Lite slave
port</lsccip:description>

<lsccip:busType library="interface" name="ahblite"
vendor="lattice" version="1.0"/>

<lsccip:abstractionTypes>

<lsccip:abstractionType>

<lsccip:abstractionRef library="interface"
name="ahblite rtl" vendor="lattice" version="1.0"/>

<lsccip:portMaps>
<lsccip:portMap>
<lsccip:logicalPort>
<lsccip:name>HSEL</lsccip:name>
</lsccip:logicalPort>
<lsccip:physicalPort>

<lsccip:name>ahbl s00 hsel slv i</lsccip:name>
</lsccip:physicalPort>
</lsccip:portMap>
<lsccip:portMap>
<lsccip:logicalPort>
<lsccip:name>HADDR</lsccip:name>
</lsccip:logicalPort>
<lsccip:physicalPort>

<lsccip:name>ahbl s00 haddr slv i</lsccip:name>
</lsccip:physicalPort>
</lsccip:portMap>
</lsccip:portMaps>
</lsccip:abstractionType>
</lsccip:abstractionTypes>
<lsccip:slave>
<lsccip:memoryMapRef memoryMapRef="ahbs mem map"/>
</lsccip:slave>
</lsccip:busInterface>
</lsccip:busInterfaces>

Figure 3.34. Example of businterface Node
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5. <addressSpaces> node: specifies the addressable area seen by bus interfaces of type master (Figure 3.35). The
description follows IP-XACT format. Refer to IEEE 1685-2014: IEEE Standard for IP-XACT, Standard Structure for
Packaging, Integrating, and Reusing IP within Tool Flows for more details.

<lsccip:addressSpaces>
<lsccip:addressSpace>
<lsccip:name>ahbm addr space</spirit:name>
<lsccip:range>4k</lsccip:range>
<lsccip:width>32</lsccip:width>
</lsccip:addressSpace>
</lsccip:addressSpaces>

Figure 3.35. Example of addressSpace Node

6. <memoryMaps> node: specifies the information about the range of registers, memory, or other address blocks
accessible through slave interface (Figure 3.36). The description follows IP-XACT format. Refer to IEEE 1685-2014:
IEEE Standard for IP-XACT, Standard Structure for Packaging, Integrating, and Reusing IP within Tool Flows for more
details and examples.

To represent dynamic availability of some elements, <register> and <field> node are extended with an optional
isPresent element (introduced in IEEE Std 1685-2014), which defines whether the enclosing element is present or
not. The value of isPresent element is a Python expression. Parameters defined in <settings> node can be used in
the expression.

If a register is used based on user configuration, the register is written to output IP-XACT file. Otherwise, the
register is not written to output IP-XACT file.
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<lsccip:memoryMaps>
<lsccip:memoryMap>
<lsccip:name>ahbs mem map</lsccip:name>
<lsccip:description>AHB-Lite Slave 0 memory
map</lsccip:description>
<lsccip:addressBlock>
<lsccip:name>registers</lsccip:name>
<lsccip:displayName>registers</lsccip:displayName>
<lsccip:description>Register Block</lsccip:description>
<lsccip:baseAddress>0</lsccip:baseAddress>
<lsccip:range>4096</lsccip:range>
<lsccip:width>32</lsccip:width>
<lsccip:usage>register</lsccip:usage>
<lsccip:access>read-write</lsccip:access>
<lsccip:register>
<lsccip:name>Status</lsccip:name>
<lsccip:displayName>Status Register</lsccip:displayName>
<lsccip:description>Status Register</lsccip:description>
<lsccip:addressOffset>0x10</lsccip:addressOffset>
<lsccip:size>4</lsccip:size>
<lsccip:volatile>true</lsccip:volatile>
<lsccip:access>read-only</lsccip:access>
<lsccip:field>
<lsccip:name>FIFO Empty</lsccip:name>
<lsccip:displayName>FIFO Empty</lsccip:displayName>
<lsccip:description>Indicates current status of the

interface in the receive direction: 0 - There is data available. 1 - The
FIFO is empty.</lsccip:description>
<lsccip:isPresent> 1 != int setting

</lsccip:isPresent>
<lsccip:bitOffset>0</1lsccip:bitOffset>
<lsccip:bitWidth>1</lsccip:bitWidth>
<lsccip:volatile>true</lsccip:volatile>
<lsccip:access>read-only</lsccip:access>
<lsccip:writeValueConstraint>
<lsccip:minimum>0</lsccip:minimum>
<lsccip:maximum>0</lsccip:maximum>
</lsccip:writeValueConstraint>
<lsccip:testable
testConstraint="unConstrained">false</lsccip:testable>
</lsccip:field>
</lsccip:register>
</lsccip:addressBlock>
</lsccip:memoryMap>
</lsccip:memoryMaps>

Figure 3.36. Example of memoryMaps Node
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7. <componentGenerators> node: contains a list of componentGenerator elements. Each componentGenerator
element defines a generator that is run on generated IP instance package. Each generator is called after other IP
instance package files are generated. For example, a component generator can generate memory initialization file
for a memory IP (Figure 3.37).

<lsccip:componentGenerators>
<lsccip:componentGenerator>
<lsccip:name>memGenerator</lsccip:name>
<lsccip:generatorExe>script/mem gen.py</lsccip:generatorExe>
</lsccip:Generator>
</lsccip:Generators>
Figure 3.37. Example of componentGenerator Node
8.

<estimatedResources> node: contains a list of estimatedResource element. Each estimatedResource element

defines the formula to calculate one type of resource used in the IP instance package. Table 3.6 shows the element
in < estimatedResource> node.

Table 3.6. Elements in estimatedResource Node

Element Value Mandatory Description

name String Yes Name of the resource.

number Python expression Yes Python script to calculate the number of the resource.
9.

<outFileConfigs> node: specifies all customized output file configuration nodes < fileConfig > for whole customized
flow. fileConfig node contains a group of attributes to specify a specific file or directory generation.
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A full description of a soft IP might be large. Metadata.xml supports to build a large XML file from small manageable
chunks. The approach is implemented by XInclude (Figure 3.38).

metadata.xml
<lsccip:ip version="1.0"
xmlns:lsccip="http://www.latticesemi.com/XMLSchema/Radiant/ip"
xmlns:xi="http://www.w3.0rg/2001/XInclude">
<lsccip:general> .. </lsccip:general>
<xi:include href="setting.xml" parse="xml" />
<xi:include href="memory map.xml" parse="xml" />
<xi:include href="address space.xml" parse="xml" />
<xi:include href="bus interface.xml" parse="xml" />
<lsccip:ports> .. </lsccip:ports>
</lsccip:ip>

setting.xml
<lsccip:settings
xmlns:lsccip="http://www.latticesemi.com/XMLSchema/Radiant/ip">
<lsccip:setting id="int setting" type="input" value type="int"
conn _mod="example" default="1" title="Integer Setting" />
<lsccip:setting id="bool with value mapping" type="param"
value type="bool" conn mod="example"

default="False" bool value mapping="('Enabled',
'Disabled')" /> B B
</lscciv:settinas>

Figure 3.38. Example of Xinclude Usage

You can use metadata.xsd in Appendix A to check the metadata file. For those elements borrowed from IPXact, refer to
the related xsd files of IPXact.

3.3.2. Implementation RTL Files

You should put all IP implementation RTL files in ‘rtlI’ sub directory of whole IP package. Lattice Builder platform does
not support hierarchical rtl directories. All RTL sources can be put in one directory level. Three file suffix names (“.v/,
‘.sv’ and ‘.vhd’) are supported for RTL files to represent ‘Verilog’, ‘System Verilog’ and ‘Vhdl’ language types
accordingly.

IP Platform always generates a wrapper module by default for the whole IP generation. This wrapper is in Verilog HDL
no matter what the language type of the IP implementation RTLs is. Providing a Verilog-HDL top to handle the interface
translation among different language types is strongly recommended.

If the IP is implemented in Verilog HDL (including System Verilog) only, all the contents are copied in one .v/.sv RTL file
and modules are defined in the wrapper top module. All module names have unified naming rule to avoid name
collision such as Top module name, PMI module name, Primitive module name, Blackbox module name.

If some portions of an IP module in the RTL file are encrypted, the corresponding portions generated in Verilog file are
also encrypted.

All the RTLs are kept and copied to an IP instance directory, if there is VHDL in IP implementation RTLs. Therefore, the
module-naming rule does not need to be unified. You can specify different lib (default is work) for VHDL source that is
specified in “wrapper” file generator (Figure 3.39).

<lsccip:outFileConfigs>
<lsccip:fileConfig name="wrapper" lib='test2.vhd=1ibA;test3.vhd=1ibB' />
</lsccip:outFileConfigs>

Figure 3.39. Example of Specifying Lib for VHDL
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3.3.3. Python Script Plugin File

Python expressions can be used in metadata file to implement complex logic. To support complex logic, you can add
any python functions in plugin.py file (Figure 3.40) of an IP package, and then call the functions in Python expressions in
metadata file.

Each setting item value can be referred to in a Python expression in metadata.xml by its ID as a Python variable. An
expression is evaluated by demand. The plugin has its individual namespace and all the setting items values are
exported to plugin as a global map variable IP_SETTINGS. You can use IP_SETTINGS [item ID] to refer to an item or set
its value in plugin code.

A global variable ‘__PLUGIN_VER’ is defined with value ‘2.0’. You can check this variable if you want to provide a plugin
that can work on both current and legacy IP platforms.

def cntr_opt():
$return {"Down" :0,
# " 'J'p L 1,
¥ "UpDown™: 2}

wn™  O),

return [{("Dc

def cntr ldir(}:
return ((CNTR DIR = 0) | (CHTR DIR = 1})

def cntr_wdt():
if (CHNTR _WIDTIH < 2):
return 2
else:

return CHNTE_WIDTH

def cntr hval
if (CHNTE_HVALUE <= CNTR_LVALUE):

ret = 0

PluginUtil.post_error("Higher count wvalus should be greater than the Lower count value.™)
else:

ret = 1

return ret

def get device name (value):
¥ = runtime_info.device_info.architecture(value)

retorn =

Figure 3.40. Template of Plugin File
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3.3.4. Memory Map CSV File

Propel 2.0 Builder supports importing memory map from a CSV file to create memory map. You can edit a CSV file.

Figure 3.41 shows the CSV file template. Each row to be imported is with one of the keywords among MEMORYMAP,

REGISTER, and FIELD. Row with no keyword is ignored, such as the header row (orange squared part in Figure 3.41).
The header row is to help identify the column.

A B T D E F G H | ]
I 0 1 2 4 5 7 3 E)

2 | name description baseAddress range width

3 |MEMORYMAFP ABC descl 0x0 32 64

4 | name displayMame  description addressOffset size volatile access

3 |REGISTER QSPI_CTRL QSPI_CTRL Q5PI Control Register 0x00 32 TRUE read-write

6 | field displayMame  description bitOffset bitWidth volatile access default testable

DEFAULT_S
7 |FIELD spi_mode spi_mode Sets the SPI mode 0 2 TRUE read-write PI_MODE TRUE
DEFAULT_S

& |FIELD sck_div sck_div Sets the SPI clock divider 3 TRUE read-write CK_DIV TRUE

9 |FIELD reserved reserved Reserved bits 5 26 TRUE read-write 0 TRUE

10 |FIELD soft_reset soft_reset Resets internal soft logic 31 1 TRUE read-write 0 TRUE

11 | name displayMame  description addressOffset size volatile access

12 |REGISTER CMD_DATA CMD_DATA Command Data Register 0x04 32 TRUE read-write

13 | field displayMame  description bitOffset bitwidth volatile access default testable
Command data to transmit
in transaction phase 1

14 |FIELD cmd_data cmd_data (always big endian) 0 32 TRUE read-write 0 TRUE

15 | name displayMame  description addressOffset size volatile access

16 |REGISTER TX_FIFO_DATA TX_FIFO_DATA Tx FIFO Data Register 0x08 32 TRUE write-only

17 name displayMame  description bitOffset bitWidth volatile access default testable
Data to transmit in

18 |FIELD tx_fifo_data  tx_fifo_data  transaction phase 2. 0 32 TRUE write-only MNA FALSE

Figure 3.41. Example of Memory Map CSV File
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4. TCL Commands

Propel Builder provides TCL commands to execute actions. You can manually enter TCL commands in Tcl Console
(Figure 4.1), if you prefer using command lines rather than using the GUI.

Tdl Console

% sbp design close
INFO - Finished: sbp design close
Finished: "sbp_design close™

% sbp design open -name hellc v -path {G:/Lattice/project/Raptor/tool/hw/hello_v/hello_v/hello_v.sbx}
% sbp design close

INFO - Finished: sbp design close
Finished: "sbp design close™

Figure 4.1. Tcl Console

4.1. sbp_design

The sbp_design command is used as one of the high-level management commands such as opening, closing, of the
design files created by the Propel Builder.

4.1.1. Open

Opens an existing Propel Builder design for modification.
Usage sbp_design open -name <design name> -path <design path> [-device <device name>]

Example sbp_design open -name projectl -path projectl.sbx

4.1.2. Close

Closes a Propel Builder design currently opened.

‘Usage |sbp_design close

4.1.3. New

Creates a new Propel Builder design.

Usage sbp_design new -name <new design name> -path <new design path>

4.1.4. Save

Saves the current Propel Builder design to file on disk, or save it as a new file. You can choose to save the design to the
project location (Example 1) or to a specific path (Example 2).

Usage sbp_design save [-path <new design path>]
Example 1 sbp_design save

Example 2 sbp_design save -path new_design.sbx
4.1.5. Drc

Runs the design rule check for the Propel Builder design file.
Usage sbp_design drc
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4.1.6. Generate

Generates RTL code to instantiate and connect the IP cores specified in the Propel Builder design file.

Usage

lsbp_design generate

4.1.7. auto_assign_addresses

Automatically assigns memory mapped addresses to all the slaves in the system. These addresses should be chosen to
avoid slaves with multiple non-contiguous address ranges.

Usage

|sbp_design auto_assign_addresses

4.1.8. Launch SoC Verification Engine

Launches the verification engine to verify design.

Usage

sbp_design verify [-h] [--workfolder <workfolder_path>] [--sbx_file <sbx_file_path>]
{sim_gen,pfr_pack,regmap_gen,auto_run}

positional arguments: {sim_gen,pfr_pack,regmap_gen,auto_run} specify the application
sim_gen Simulation Generation Flow
pfr_pack PFR Security Engine Packager Flow
regmap_gen Memory Map Generation Flow
auto_run Automation Flow

optional arguments:
-h, --help show this help message and exit
--workfolder WORKFOLDER, -wf WORKFOLDER
assign the working folder. Otherwise, the default one (current working folder) will be
used
--sbx_file SBX_FILE, -sf SBX_FILE
specify the sbx file

Example

sbp_design verify --workfolder ./mem_map --sbx_file D:/ /XO3D_lInitial/XO3D_lInitial.sbx
regmap_gen

4.1.9. Execute PGE Engine

Runs command with different parameters to call SGE function, DGE function, and Signature.

e  Runs command to call SGE to generate files for SDK.

Usage

sbp_design pge sge —i <input path> [-0 <output path>]

-i [Required] the top-level SoC project sbx file full path.

-0 [Optional] output full path, if the parameter is not specified, output path is the same as SoC
project path. sge folder is generated at output path, at present sge folder under the SoC project root
directory.
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e  Runs command to call DGE to generate TCL script that can be used to generate a Diamond or Radiant project.
Usage sbp_design pge dge —i <input path> [-o <output path>] [-diamond [-radiant]

-i [Required] the top level SoC project sbx file full path.

-0 [Optional] output full path, if the parameter is not specified, output path is the same as SoC
project path. For DGE, tcl script and related files are generated at output path. At present, Diamond
or Radiant project share the same workspace with SoC project.

-diamond [Optional] flag to execute DGE for diamond project.

-radiant [Optional] flag to execute DGE for Radiant project.

e Run command to generate signature.

PGE gets partial UFM3 contents including version packet (C), Sentry PFR configure data (D), and call Flash Address
Tool to sign with private key from Factory HSM.

Usage ‘sbp_design pge gen_signature -cfile <c binary file> -dfile <d binary file> -output <output binary file>
4.1.10.Undo

Undo operation. Currently, software only supports single undo.

Usage Iundo

4.1.11.Redo

Redo operation. Currently, software only supports single redo.

‘Usage lredo

4.2. Other TCL Commands

The following commands are used for specifying connectivity and IP instantiation to the Propel Builder backend.

4.2.1. sbp_add_component

Instantiates an IP component into the system. Must specify the component VLNV identifier. This corresponds to a
component instance in the IP-XACT design. For example, the command below can instantiate an AHB-Lite interconnect
component.

Usage sbp_add_component -vinv <VLNV> -name <instance_name>

Example sbp_add_component -vinv lattice:ip:ahbl_interconnect:1.0 -name ahblite_interconnect

4.2.2. sbp_add_sbx_component

Instantiates a hierarchical component from sbx file into the system.
Usage sbp_add_sbxcomp -name <hname> -path <sbx_file_absolute_path_name>

Example sbp_add_sbxcomp -name sim_comp -path “C:/test/test.sbx”
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4.2.3. shp_add_gluelogic

Instantiates an gluelogic component into the system.

Usage sbp_add_gluelogic —name <instance_name> -logicinfo <logic json info from sbp_create_glue_logic>
Example sbp_add_gluelogic -name equation_module_inst -logicinfo [sbp_create_glue_logic equation
equation_module {} { {"expr":"!A & IB","module_name":"equation_module"}}]

4.2.4. shp_create_glue_logic

Create gluelogic information when adding gluelogic component. rtl_path must be a file path if gluelogic comes from a
file. Else be empty.

Usage sbp_create_glue_logic <type><module_name> <rtl_path> <json cfg data>

Example sbp_add_gluelogic -name equation_module_inst -logicinfo [sbp_create_glue_logic equation

equation_module {} { {"expr":"!A & IB","module_name":"equation_module"}}]

4.2.5. sbp_add port
Creates a top-level I/0 port. Must specify the direction.

‘Usage ‘sbp_add_port [-from <bit number>] [-to <bit number>] -direction <in/out/inout> <port_name>

4.2.6. sbp_connect_net

Connects all of the specified pins and/or ports to the same net. The arguments can be pins or ports in the system
design. Only one of the arguments can be the driver (output pin/port), driving all other input pin/ports. Example below
connects the clk port to all components, assuming component pins are all named clk.

Usage sbp_connect_net [-name <net name>] <pin/port> <pin/port>

Example sbp_connect_net [sbp_get_pins clk] {CLOCK_IN}

4.2.7. sbp_connect_interface_net

Connects a bus interface pin/port to another interface pin/port. This corresponds to the interconnection element in the
IP-XACT design.

‘Usage |sbp_con nect_interface_net <pin/port> <pin/port>

4.2.8. shp_connect_constant

Connects a constant integer to a pin/pinbus/port/portbus. To assign to a pin/pinbus, the object must be an input
pin/pinbus. To assign to a port/portbus, the object must be an output port/portbus. If the integer requires multiple
bits, not 0 or 1, then the object must be a bus. The tcl command can be used to assign the same constant to multiple
pin/pinbus/port/portbus at the same time.

Usage sbp_connect_constant -constant <integer> <pin/pin bus/ port/portbus> <pin/pin bus/
port/portbus>...
Example sbp_connect_constant -constant 1 {test/i2c_mst_apb/rst_n_i} {test/riscv/clk_i}

4.2.9. shp_connect_whitebox

User can do connection cross the hierarchy boundary for verification purpose.

Usage sbp_connect_whitebox <design_name/vip_inst_name/pin_name>
<design_name/uit_inst_name/port_name>
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4.2.10.disconnect whitebox connection

Removes the connection cross the hierarchy boundary.
Usage sbp_disconnect_whitebox <design_name/vip_inst_name/pin_name>
<design_name/uit_inst_name/port_name>

4.2.11.sbp_disconnect_interface_net

Disconnects an interface pin/port from the interface nets they attached to. Note that any interface pin or interface port
can attach to one interface net at the most.
‘Usage |sbp_disconnect_interface_net <pin/port> <pin/port>

4.2.12.sbp_disconnect_net

Disconnects all of the specified input pins and/or ports from the nets they attached to. Note that any pin or port can
attach to one net at the most. Can also be used to disconnect a constant that is connected to a pin/port with
connect_constant.

‘Usage |sbp_disconnect_net <pin0> <pinl> <port2>

4.2.13.sbp_assign_addr_seg

Assigns a memory map between a pair of master and slave interfaces. Range specifies the range of the segment, for
example, 32'h0000400, 32'‘h0001000. Offset specifies the base offset of the range, for example, 32‘h0000400
Usage sbp_assign_addr_seg -offset <offset> <slave connection name>

Example sbp_assign_addr_seg -offset 32‘h00001000 simple/riscv/AHBL_S00

4.2.14.sbp_unassign_addr_seg

The Tcl command unsets the fixed offset flag for a memory map allowing the auto_assign Tcl command to assign the
memory map offset.
Usage sbp_unassign_addr_seg <slave interface name>

Example sbp_unassign_addr_seg simple/spi/AHB_S00

4.2.15.sbp_assign_local_memory

Assigns a base address to a local memory map of a master address space.
Usage sbp_assign_local_memory -offset <offset> <master_addr_space>

Example sbp_assign_local_memory -offset ‘h0050000 Foundation_SoC/riscv/ahbl_m_data_Address_Space

4.2.16.sbp_export_pins

Exports a list of pins or interface pins, or all not-yet-connected pins of the components to the top-level port list in the
design. The function detects whether or not the argument is pin(s) or component(s). In the two examples below,
Example 1 demonstrates a Tcl command to export the pin init_done, while Example 2 demonstrates a Tcl command to
export all pins and interfaces of the ddr3 component.

Usage sbp_export_pins <pin/component> <pin/component>
Example 1 sbp_export_pins {ddr3/init_done}
Example 2 sbp_export_pins {ddr3}
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4.2.17.sbp_export_interface

Exports bus interfaces that are passed as arguments to the Tcl command from the component to the top-level
component. Example below exports the AHBL_MASTER bus interface of the RISC-V component to the top-level

component.
Usage sbp_export_interfaces <interface> <interface> <interface>
Example sbp_export_interfaces simple/riscv/AHBL_MASTER

4.2.18.sbp_rename

The rename Tcl command renames objects with in the design. The new name of the object and the current hierarchical
name of the given object are used as the parameter value. The object can be an interface connection, connection, port,
interface, or component. The example below demonstrates the changing of the name of a port in milestone project
from CLK to CLOCK.

Usage

sbp_rename -name <new name> <object name>

Example

sbp_rename -name CLOCK milestone/CLK

4.2.19.sbp_replace

The Replace (Re-Config) Tcl command replaces a component with a new configuration for itself. VLNV refers to the
newly-generated IP, component name refers to the existing component that is to be replaced, and instance refers to
the instance name of the component with new configuration.

Usage

sbp_replace -vinv <VLNV> -name <instance> -component <component name>

Example

sbp_replace -vinv lattice:ip:ahblite_bus_0:1.1 -name ahbl_bus_0 -component simple/ahblite

4.2.20.sbp_copy

Copies objects, IP instances and nets, from the current or other open sbp designs to the current sbp design. All objects
are post-fixed with a postfix string. For example, you can write TCL code below to duplicate the components and
connections with new instance names post fixed with X, by calling copy on all the components, ports and nets. Pins are
automatically duplicated while the components are duplicated.

Usage

sbp_copy -postfix <postfixString> objects

Example

sbp_copy —postfix X Sselected_objs

4.2.21.sbp_delete

Deletes objects, IP instances and nets, from the current sbp design. In the examples below, Example 1 demonstrates a
Tcl command to delete a port, while Example 2 demonstrates a Tcl command to delete ddr3 component.

Usage Sbp_delete objects -type <type name>
Example 1 sbp_delete [sbp_get_ports <clock>] -type port
Example 2 sbp_delete {ddr3} -type component
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4.2.22.sbp_get_pins

Gets a list of pin names that match a pattern string, and/or the pins that are associated with an object. The object in
the [-from <objectName>] option can be a net or a component. The example below gets the clk pin from the
interconnect IP.

Usage sbp_get_pins [-from <object Name>] [pattern]

Example sbp_get_pins -from ahblite_interconnect clk

4.2.23.sbp_get_interface_pins

Gets a list of interface names that match a pattern string, and/or the interfaces that are associated with an object. The
object in the [-from <objectName>] option can be an interface net or a component. The example below can get all
AHB-Lite slave interface pins from the interconnect IP.

Usage: sbp_get_interface_pins [-from <objectName>] [pattern]

Example: sbp_get_interface_pins -from ahblite_interconnect S*_AHB

4.2.24.sbp_get_ports

Get a list of the names of ports that match a pattern string, and/or the ports that are associated with an object. The
object in the [-from <objectName>] option can be a net.
‘Usage ‘sbp_get_ports [-from <objectName>] [pattern]

4.2.25.sbp_get_interface_ports

Gets a list of interface names that match a pattern string, and/or the interface ports that are associated with an object.
The object in the [-from <objectName>] option can be an interface net.

‘Usage ‘sbp_get_interface_ports [-from <objectName>] [pattern]

4.2.26.sbp_get_nets

Gets a list of net names that match a pattern string, and/or the nets that are associated with an object. The object in
the [-from <objectName>] option can be a pin or a port.
‘Usage |sbp_get_nets [-from <objectName>] [pattern]

4.2.27.sbp_get_interface_nets

Gets a list of interface net names that match a pattern string, and/or the interface nets that are associated with an
object. The object in the [-from <objectName>] option can be an interface pin or an interface port.
‘Usage ‘sbp_get_interface_nets [-from <objectName>] [pattern]

4.2.28.sbp_set_property

Sets the properties of an input object. The first argument is a list of name value pairs. We have a list of parameters
because the GUI IP configuration dialog submits changes to many parameters of an IP component at the same time
when the dialog is closed. In the examples below, Example 1 changes the data width of the RAM block named “ebr_0",
while Example 2 changes the number of master interfaces to two and number of slave interface to three on AHB-Lite
interconnect block named “ahbl_interconnect”.

Usage sbp_set_property <name0O value0 namel valuel ...> object
Example 1 sbp_set_property {datawidth 32} {test/ebr_0}
Example 2 sbp_set_property {NUM_MI 2 NUM_SI 3} test/ahbl_interconnect
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4.2.29.sbp_get_property

Gets the property of the object. The example below is to get the number of slave interfaces of AHB-Lite interconnect
block named “ahbl_interconnect_0".

Usage sbp_get_property <parameter name> <object>

Example sbp_get_property NUM_SI ahbl_interconnect_0

4.2.30.sbp_report_properties

Prints all the properties and values associated to the type of the object.

Usage sbp_report_properties object

Example sbp_report_properties ahbl_interconnect

Outputs Name: ahbl_interconnect
NUM_SI: 1

NUM_MI: 2
DATA_WIDTH: 32
IADDRESS_WIDTH: 32

4.2.1. shp_get_components

Gets a list of component names that match a pattern string, and/or the components that are associated with an object.
The default pattern string is a wildcard “*” that matches all components. The pattern string may consist of string
segments and wildcards. The example below returns all the component names that contain “interconnect”. The
command returns an empty string if no match is found.

Usage sbp_get_components <component name>

Example sbp_get_components {*interconnect*}
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Appendix A. metadata.xsd

<?xml version="1.0" encoding="gb2312"?>

<!-- IP Metadata Schema 0.0.4 -->
<t--
Change Log:

0.0.0 21-Jul-2016 initial revision.
0.0.1 22-Jul-2016 1. removed enum value from <setting> 2. change
value mapping to scriptType B
0.0.2 29-Jul-2016 1. removed GUI out of metadata scope
0.0.3 30-Jul-2016 1. add value list support
0.0.4 12-Dec-2020 1. all new features for radiant 3.0.
-—>
<xs:schema xmlns:xs="http://www.w3.0rg/2001/XMLSchema"
targetNamespace="http://www.latticesemi.com/XMLSchema/Radiant/ip"
xmlns:lsccip="http://www.latticesemi.com/XMLSchema/Radiant/ip"
elementFormDefault="qualified"
attributeFormDefault="unqualified">
<xs:include schemalLocation="busInterface.xsd"/>
<xs:include schemalocation="memoryMap.xsd"/>
<xs:include schemalocation="file.xsd"/>
<xs:include schemalLocation="generator.xsd"/>
<xs:include schemalocation="design.xsd"/>

<xs:attributeGroup name="ipany.att">
<xs:anyAttribute processContents="lax"/>
</xs:attributeGroup>
<!-- version string type definition-->
<xs:simpleType name="threeFigureVersionType">
<xs:annotation>
<xs:documentation>
The syntax for version string.
</xs:documentation>
</xs:annotation>
<xs:restriction base="xs:string">
<xs:pattern value="[0-9]+\.[0-9]+\.[0-9]+"/>
</xs:restriction>
</xs:simpleType>

<xs:simpleType name="twoFigureVersionType">
<xs:annotation>
<xs:documentation>
The syntax for Radiant version string.
</xs:documentation>
</xs:annotation>
<xs:restriction base="xs:string">
<xs:pattern value="[0-9]+\.[0-9]1+"/>
</xs:restriction>
</xs:simpleType>

<xs:simpleType name="scriptType">
<xs:annotation>
<xs:documentation>
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Any python expressions. Could be a simple const variable like
&quot;l&quot;,
or a tuple &quot; (0, 10)&quot;, or a function call
&quot;user funcl () &quot;,
or a complex expression &quot;a==l2&quot;
</xs:documentation>
</xs:annotation>
<xs:restriction base="xs:string"/>
</xs:simpleType>

<xs:simpleType name="settingTypeType">
<xs:annotation>
<xs:documentation>
Is this setting variable for parameter of IP core module, or just for
user input?
Valid values are &quot;inputé&quot; and &quot;param&quot; .
</xs:documentation>
</xs:annotation>
<xs:restriction base="xs:string">
<xs:enumeration value="param"/>
<xs:enumeration value="input"/>
<xs:enumeration value="command" />
</xs:restriction>
</xs:simpleType>

<xs:simpleType name="settingValueType">
<xs:annotation>
<xs:documentation>
Value type of setting variable. Valid types are &quot;boolé&quot;,
&quot;string&quot; and &quot;int&quot;
</xs:documentation>
</xs:annotation>
<xs:restriction base="xs:string">
<xs:enumeration value="bool"/>
<xs:enumeration value="string"/>
<xs:enumeration value="int"/>
<xs:enumeration value="float"/>
<xs:enumeration value="path"/>
</xs:restriction>
</xs:simpleType>

<xs:simpleType name="settingDefaultType">
<xs:annotation>
<xs:documentation>
Default value of setting wvariable.
</xs:documentation>
</xs:annotation>
<xs:restriction base="xs:string"/>
</xs:simpleType>

<xs:simpleType name="settingOutputFormatterType">
<xs:annotation>
<xs:documentation>
Formatter of output.
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</xs:documentation>
</xs:annotation>
<xs:restriction base="xs:string">
<xs:enumeration value="str"/>
<xs:enumeration value="nostr"/>
</xs:restriction>
</xs:simpleType>

<!-- ip.settings.setting-->
<xs:complexType name="settingElementType">
<xs:annotation>
<xs:documentation>
Setting variable definition.
</xs:documentation>
</xs:annotation>

<xs:attribute name="id" type="xs:string" use="required" />

<xs:attribute name="type" type="lsccip:settingTypeType"
use="required" />

<xs:attribute name="value type" type="lsccip:settingValueType"
use="required" />

<xs:attribute name="conn mod" type="xs:string" use="required" />

<xs:attribute name="default" type="lsccip:settingDefaultType"
use="optional" />

<xs:attribute name="value expr" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="drc" type="lsccip:scriptType" use="optional" />

<xs:attribute name="editable" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="description" type="xs:string" use="optional" />

<xs:attribute name="title" type="xs:string" use="optional" />

<xs:attribute name="hidden" type="xs:string" use="optional" />

<xs:attribute name="regex" type="xs:string" use="optional" />

<xs:attribute name="options" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="value range" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="groupl" type="xs:string" use="optional" />

<xs:attribute name="group2" type="xs:string" use="optional" />

<xs:attribute name="bool value mapping" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="output formatter"
type="1sccip:settingOutputFormatterType" use="optional" />

<xs:attribute name="config groups" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="process path" type="xs:boolean" use="optional"

default="true"></xs:attribute> B
</xs:complexType>

<!-- ip.settings -->
<xs:complexType name="settingsType">
<xs:sequence>
<xs:element minOccurs="0" maxOccurs="unbounded" name="setting"
type="1lsccip:settingElementType" />
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</xs:sequence>
</xs:complexType>

<!-- ip.ports.port-->
<xs:complexType name="portElementType">

<xs:annotation>
<xs:documentation>IP port definition.</xs:documentation>

</xs:annotation>

<xs:attribute name="name" type="xs:string" use="required" />

<xs:attribute name="dir" type="xs:string" use="required" />

<xs:attribute name="conn mod" type="xs:string" use="required" />

<xs:attribute name="conn port" type="xs:string" use="optional" />

<xs:attribute name="conn range" type="xs:string" use="optional" />

<xs:attribute name="range" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="stick high" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="stick low" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="stick value" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="dangling" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="bus interface" type="xs:string"
use="optional" />

<xs:attribute name="attribute" type="lsccip:scriptType"
use="optional" />

<xs:attribute name="port type" use="optional" default="data">
<xs:simpleType>

<xs:restriction base="xs:string">

<xs:enumeration
<xs:enumeration
<xs:enumeration

value="data"></xs:enumeration>
value="reset"></xs:enumeration>
value="clock"></xs:enumeration>

</xs:restriction>
</xs:simpleType>
</xs:attribute>
</xs:complexType>
<!-- ip.outFileConfigs -->
<xs:complexType name="outFileConfigsType">
<xs:sequence>
<xs:element maxOccurs="unbounded" name="fileConfig"
type="lsccip:fileConfigType" />
</xs:sequence>
</xs:complexType>
<!-- ip.outFileConfigs.fileConfig -->
<xs:complexType name="fileConfigType">
<xs:annotation>
<xs:documentation>Configure output file</xs:documentation>
</xs:annotation>
<xs:attribute name="name" type="xs:string" use="required"
<xs:attribute name="use" use="optional" default="merge">
<xs:annotation>
<xs:documentation>
Merge the new attributes to existing configuration or

/>
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replace all
</xs:documentation>
</xs:annotation>
<xs:simpleType>
<xs:restriction base="xs:string">
<xs:enumeration value="merge"></xs:enumeration>
<xs:enumeration value="replace"></xs:enumeration>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
<xs:attribute name="type" use="optional" default="file">
<xs:annotation>
<xs:documentation>
Indicate the item is generate a file or directory
</xs:documentation>
</xs:annotation>
<xs:simpleType>
<xs:restriction base="xs:string">
<xs:enumeration value="file"></xs:enumeration>
<xs:enumeration value="directory"></xs:enumeration>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
<xs:attribute name="description" type="xs:string"
use="optional">
</xs:attribute>
<xs:attribute name="enable output" type="xs:string" use="optional"
default="True">
<xs:annotation>
<xs:documentation>
Python expression represent a boolean value to
indicate the output is enabled or disabled
</xs:documentation>
</xs:annotation>
</xs:attribute>
<xs:attribute name="phase" type="xs:int" use="optional"
default="0">
</xs:attribute>
<xs:attribute name="file base name" type="xs:string"
use="optional">
</xs:attribute>
<xs:attribute name="file suffix" type="xs:string"
use="optional">
</xs:attribute>
<xs:attribute name="sub dir" type="xs:string"
use:"optional"></xs:attribute;
<xs:attribute name="file generator" type="xs:string"
use="optional">
</xs:attribute>
<xs:attribute name="src dir" type="xs:string"
use="optional">
</xs:attribute>
<xXs:attribute name="dest dir" type="xs:string"
use="optional">
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</xs:attribute>
<xs:attribute name="src file" type="xs:string"
use="optional">
</xs:attribute>
<xs:attribute name="export" use="optional" default="input only">
<xs:annotation>
<xs:documentation>
Indicate export all setting items or input only
</xs:documentation>
</xs:annotation>
<xs:simpleType>
<xs:restriction base="xs:string">
<xs:enumeration value="all"></xs:enumeration>
<xs:enumeration value="input only"></xs:enumeration>
</xs:restriction>
</xs:simpleType>
</xs:attribute>
<xs:attributeGroup ref="lsccip:ipany.att"/>
</xs:complexType>
<!-- ip.interface-->
<xs:complexType name="portsType">
<xs:sequence>
<xs:element maxOccurs="unbounded" minOccurs="1" name="port"
type="1lsccip:portElementType" />
</xs:sequence>
</xs:complexType>

<!-- ip.interface-->
<xs:complexType name="generalType">
<xs:sequence>

<xs:element maxOccurs="1" minOccurs="0" name="vendor"
type="xs:string" />

<xs:element maxOccurs="1" minOccurs="0" name="library"
type="xs:Name" />

<xs:element maxOccurs="1" minOccurs="1" name="name"
type="xs:string" />

<xs:element maxOccurs="1" minOccurs="0" name="display name"
type="xs:string" />

<xs:element maxOccurs="1" minOccurs="1" name="version"
type="xs:string" />

<xs:element maxOccurs="1" minOccurs="1" name="category"
type="xs:string" />

<xs:element maxOccurs="1" minOccurs="0" name="keywords"
type="xs:string" />

<xs:element maxOccurs="1" minOccurs="0" name="type"
type="xs:string" />

<xs:element maxOccurs="1" minOccurs="0" name="instantiatedOnce"
type="xs:boolean" />

<xs:element maxOccurs="1" minOccurs="1"

name="min radiant version" type="lsccip:twoFigureVersionType" />

<xs:element maxOccurs="1" minOccurs="0"

name="max radiant version" type="lsccip:twoFigureVersionType" />

<xs:element maxOccurs="1" minOccurs="0" name="min esi version"
type="1sccip:twoFigureVersionType" />
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<xs:element maxOccurs="1" minOccurs="0" name="max esi version"
type="1lsccip:twoFigureVersionType" />
<xs:element maxOccurs="1" minOccurs="1"
name="supported products" type="lsccip:supportedProductsType" />
<xs:element maxOccurs="1" minOccurs="0"
name="supported platforms" type="lsccip:supportedPlatformsType" />
</xs:sequence>
</xs:complexType>

<xs:complexType name="supportedPlatformsType">
<xs:sequence>
<xs:element maxOccurs="unbounded" minOccurs="1" name="supported platform"
type="1sccip:supportedPlatformType" /> B
</xs:sequence>
</xs:complexType>

<xs:complexType name="supportedPlatformType">
<xs:attribute name="name" type="xs:string"/>
</xs:complexType>

<xs:complexType name="supportedProductsType">
<xs:sequence>
<xs:element maxOccurs="unbounded" minOccurs="1" name="supported family"
type="1sccip:supportedFamilyType" /> -
</xs:sequence>
</xs:complexType>

<xs:complexType name="supportedFamilyType">
<xs:sequence>
<xs:element maxOccurs="unbounded" minOccurs="0" name="supported device"
type="1sccip:supportedDeviceType" /> B
</xs:sequence>
<xs:attribute name="name" type="xs:string"/>
</xs:complexType>

<xs:complexType name="supportedDeviceType">
<xs:sequence>
<xs:element maxOccurs="unbounded" minOccurs="0"
name="supported speed grade" type="lsccip:supportedSpeedType" />
</xs:sequence>
<xs:attribute name="name" type="xs:string"/>
</xs:complexType>

<xs:complexType name="supportedSpeedType">
<xs:sequence>
<xs:element maxOccurs="unbounded" minOccurs="0" name="supported package"
type="1lsccip:supportedPackageType" /> B
</xs:sequence>
<xs:attribute name="name" type="xs:string"/>
</xs:complexType>

<xs:complexType name="supportedPackageType">
<xs:attribute name="name" type="xs:string"/>
</xs:complexType>
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<!-- ip.estimatedResources -->
<xs:complexType name="estimatedResourcesType">
<xs:annotation>
<xs:documentation>
IP estimated resources definition.
</xs:documentation>
</xs:annotation>
<xs:sequence>
<xs:element name="estimatedResource" type="lsccip:estimatedResourceType"
minOccurs="1" maxOccurs="unbounded" />
</xs:sequence>
</xs:complexType>

<xs:complexType name="estimatedResourceType">
<xs:sequence>
<xs:element name="name" type="xs:string"/>
<xs:element name="number" type="xs:string"/>
</xs:sequence>
</xs:complexType>

<!-- ip -->
<xs:element name="ip">
<xs:complexType>
<xs:sequence>
<xs:element name="general" type="lsccip:generalType" />
<xs:element name="settings" type="lsccip:settingsType" />
<xs:element name="ports" type="lsccip:portsType" />
<xs:element name="outFileConfigs" type="lsccip:outFileConfigsType"
maxOccurs="1" minOccurs="0">
<xs:unique name="fileCfgKey">
<xs:selector xpath="lsccip:fileConfig"/>
<xs:field xpath="@name"/>
</xs:unique>
</xs:element>
<xs:element ref="lsccip:busInterfaces" minOccurs="0" />
<xs:element ref="lsccip:addressSpaces" minOccurs="0" />
<xs:element ref="lsccip:memoryMaps" minOccurs="0" />
<xs:element ref="lsccip:componentGenerators" minOccurs="0" />
<xs:element ref="lsccip:choices" minOccurs="0" />
<xs:element ref="lsccip:fileSets" minOccurs="0" />
<xs:element ref="lsccip:design" minOccurs="0"
maxOccurs="unbounded" />
<xs:element name="estimatedResources"
type="1lsccip:estimatedResourcesType" minOccurs="0" />
<xs:element ref="lsccip:parameters" minOccurs="0" />
</xs:sequence>
<xs:attribute name="version" type="lsccip:twoFigureVersionType"/>
</xs:complexType>
</xs:element>

</xs:schema>
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Technical Support Assistance

Submit a technical support case through www.latticesemi.com/techsupport.
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